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1.0 Το περιβάλλον του SPSS 

Το SPSS έχει την ίδια γενική µορφή που έχουν σχεδόν όλες οι εφαρµογές που 

«τρέχουν» σε περιβάλλον Windows. Ο χρήστης µπορεί να εκτελέσει σχεδόν 

οποιαδήποτε στατιστική ανάλυση και επεξεργασία των δεδοµένων του σε ένα χρηστικό 

παραθυρικό περιβάλλον. Ωστόσο, είναι δυνατή η στατιστική επεξεργασία των 

δεδοµένων και µέσα από ένα προγραµµατιστικό περιβάλλον, στο οποίο όµως δεν θα 

γίνει αναφορά σε αυτό το σύντοµο οδηγό. 

Για να ξεκινήσετε την εφαρµογή, πηγαίνετε στο µενού [Έναρξη => Προγράµµατα => 
SPSS for Windows] και επιλέξτε το εικονίδιο του SPSS 13.0 for Windows. Η 

εφαρµογή θα ξεκινήσει σύντοµα και θα εµφανιστεί το παρακάτω πλαίσιο διαλόγου (βλ. 

Σχήµα 1.1): 

 

Σχήµα 1.1 Η εισαγωγική οθόνη του SPSS  

 

Όπως βλέπετε, έχετε πέντε διαφορετικές επιλογές: να παρακολουθήσετε το πρόγραµµα 

εκµάθησης της εφαρµογής [Run the tutorial], να εισάγετε δεδοµένα πληκτρολογώντας 

τα [Type in data], να εκτελέσετε ένα ερώτηµα [Run an existing query], να 

δηµιουργήσετε ένα ερώτηµα χρησιµοποιώντας τον Database Capture Wizard [Create 
new query using Database Capture Wizard], ή να ανοίξετε ένα αρχείο [Open an 
existing file]. 
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Επιλέξτε το [Type in data] και κάντε κλικ στο κουµπί [ΟΚ]. Η οθόνη που εµφανίζεται 

(Σχήµα 1.2) είναι παρόµοια µε αυτήν πολλών εφαρµογών λογιστικού φύλλου. Αν 

επιλέξετε την επιλογή [Don’t show this dialog in the future] στην οθόνη του Σχήµατος 

1.1 ανοίγοντας το SPSS θα ξεκινάτε από αυτήν την οθόνη. 

 

Σχήµα 1.2 Η αρχική οθόνη του SPSS 

 

 

Όπως βλέπετε, στη γραµµή µενού υπάρχουν µια σειρά από επιλογές σχετικές µε τις 

διάφορες λειτουργίες του προγράµµατος. Υπάρχουν επίσης εικονίδια συντόµευσης για 

άµεση πρόσβαση σε λειτουργίες που γίνονται συχνά. Τοποθετώντας το δείκτη του 

ποντικιού πάνω από αυτά για λίγο εµφανίζεται µια σύντοµη επεξήγηση της λειτουργίας 

τους. Το Σχήµα 1.2 παρουσιάζει ένα άδειο φύλλο δεδοµένων (data sheet). Τα δεδοµένα 

µπορούν να εισαχθούν είτε πληκτρολογώντας τα είτε εισάγοντάς τα από κάποιο αρχείο. 

Ρίχνοντας µια πρόχειρη µατιά στο µενού [File] διαπιστώνουµε ότι πολλές από τις 

επιλογές του µας είναι ήδη γνωστές από άλλες παραθυρικές εφαρµογές (Σχήµα 1.3). Για 
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παράδειγµα, η επιλογή [New] χρησιµοποιείται για να δηλωθεί ο τύπος του παραθύρου 

που θα ανοίξει. Οι διάφορες εναλλακτικές επιλογές στο [New] είναι: 

• [Data] Προεπιλεγµένο παράθυρο µε ένα άδειο φύλλο δεδοµένων έτοιµο για 

αναλύσεις. 

• [Syntax] Εκεί κάποιος µπορεί να γράψει κώδικα αντί να χρησιµοποιήσει τα 

µενού επιλογών. Η χρήση των σχετικών εντολών περιγράφεται στα εγχειρίδια 

του SPSS. 

• [Output] Κάθε φορά που «τρέχουµε» µια εντολή, το αποτέλεσµά της 

κατευθύνεται σε ένα ξεχωριστό παράθυρο εξόδου. Μπορούµε µάλιστα να έχουµε 

πολλαπλά παράθυρα εξόδου [Output] ανοιχτά προκειµένου να οργανώνουµε τα 

αποτελέσµατα των διαφόρων αναλύσεων που εκτελούµε. Αργότερα αυτά τα 

αποτελέσµατα µπορεί να αποθηκευτούν ή/και να εκτυπωθούν. 

• [Draft Output] Παρόµοιο µε το [Οutput] αλλά χρησιµοποιείται µία παλαιότερη 

µορφή παρουσίασης των αποτελεσµάτων.  

• [Script] Το παράθυρο αυτό δίνει στο χρήστη τη δυνατότητα να συντάξει πλήρη 

προγράµµατα σε µια γλώσσα που µοιάζει αρκετά µε τη BASIC. Τα προγράµµατα 

αυτά έχουν πρόσβαση στις λειτουργίες του SPSS. Με αυτή την πρόσβαση είναι 

δυνατόν κάποιος να δηµιουργήσει δικές του διαδικασίες – που δεν αποτελούν 

µέρος του SPSS – αξιοποιώντας τις λειτουργίες του SPSS. Και πάλι, αυτή η 

δυνατότητα ξεφεύγει από το αντικείµενο αυτών των σηµειώσεων. 
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Σχήµα 1.3 Το µενού επιλογών του [File] 

 

Επίσης, στο µενού [File] υπάρχουν δύο ξεχωριστές διέξοδοι για την ανάγνωση 

δεδοµένων από υπάρχοντα αρχεία (Σχήµα 1.3). Η πρώτη είναι η επιλογή [Open]. Όπως 
και σε πολλές άλλες εφαρµογές (π.χ., Word, Excel, ....) το SPSS έχει τη δική του 

µορφοποίηση για τα δεδοµένα που αποθηκεύονται µέσα από αυτό. Στην περίπτωση 

αυτή, η αποδεκτή προέκταση ονόµατος αρχείου είναι το "sav". Έτσι, µπορούµε για 

παράδειγµα να έχουµε αποθηκευµένο ένα αρχείο µε το όνοµα "data1.sav". Ωστόσο, 

αυτή η µορφοποίηση δεν είναι αναγνώσιµη από άλλα προγράµµατα, γιατί είναι σε 

δυαδική µορφή (binary format). Το πλεονέκτηµα είναι ότι όλες οι αλλαγές στη 

µορφοποίηση διατηρούνται και το αρχείο µπορεί να αναγνωστεί ταχύτερα, µέσα από την 

επιλογή [Open], η οποία προορίζεται για αρχεία αποθηκευµένα σε µορφοποίηση SPSS. 

Η δεύτερη επιλογή, [Read Text Data], όπως υποδηλώνει και το όνοµά της προορίζεται 

για την ανάγνωση αρχείων που έχουν αποθηκευτεί σε µορφοποίηση ASCII.  
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2.0 Εισαγωγή ∆εδοµένων 

Για να εισάγετε δεδοµένα στην εφαρµογή, απλώς κάντε κλικ µε το αριστερό πλήκτρο του 

ποντικιού στο πάνω αριστερά κελί του φύλλου δεδοµένων. Αρχίστε να πληκτρολογείτε 

τα δεδοµένα όπως βλέπετε στο Σχήµα 2.1. Συνήθως τα δεδοµένα εισάγονται 

οριζοντίως. Οι γραµµές του πίνακα αντιστοιχούν σε περιπτώσεις (συµµετέχοντες) και οι 

στήλες σε µεταβλητές. Έτσι, η συνήθης λογική είναι να εισάγουµε τα δεδοµένα ενός 

συµµετέχοντα για όλες τις µεταβλητές. 

Στο Σχήµα 2.1 η πρώτη στήλη αναπαριστά «Χρόνο αντίδρασης σε 100στά του 

δευτερολέπτου» και η δεύτερη δείχνει «Συχνότητα». Όπως είπαµε, οι στήλες 

αντιπροσωπεύουν τις µεταβλητές και οι σειρές τις περιπτώσεις. 

 

Σχήµα 2.1 Εισαγωγή δεδοµένων 

 

 

Αν πληκτρολογείτε δεδοµένα για πρώτη φορά, όπως στο παράδειγµα αυτό, τότε τα 

ονόµατα των µεταβλητών θα δηµιουργηθούν αυτόµατα (π.χ., var00001, var00002,....). 

Προφανώς, δεν είναι πολύ βοηθητικά τα ονόµατα αυτά. Προκειµένου να αλλάξετε τα 

ονόµατα αυτά, θα πρέπει να µεταβούµε από την κατάσταση προβολής [Data View] 
στην κατάσταση προβολής [Variable View] (βλ. Σχήµα 2.2). 
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Σχήµα 2.2 Εναλλαγή κατάστασης προβολής 

 
 

Σχήµα 2.3 Κατάσταση προβολής [Variable View] 

 
 

Στο Σχήµα 2.3 παρουσιάζεται η κατάσταση προβολής [Variable View]. Εδώ έχουµε 

αντιστροφή της παρουσίασης των µεταβλητών, οι οποίες πλέον εµφανίζονται στις σειρές 

του πίνακα, ενώ στις διάφορες στήλες µπορούµε να καθορίσουµε διάφορα 

χαρακτηριστικά για κάθε µεταβλητή. 



10  Μεθοδολογία Έρευνας & Στατιστική 
 
 
Από αριστερά προς τα δεξιά για κάθε µεταβλητή µπορούµε να καθορίσουµε τα 

ακόλουθα: 

 

• [Name] Εδώ µπορούµε να καθορίσουµε το όνοµα της µεταβλητής. Οι νεώτερες 

εκδόσεις του SPSS δέχονται ελληνικούς χαρακτήρες, αλλά προτείνεται η χρήση 

ονοµάτων µεταβλητών µέχρι 8 λατινικούς χαρακτήρες χωρίς κενά, προκειµένου 

να διατηρηθεί η συµβατότητα του αρχείου µας µε παλαιότερες εκδόσεις του 

SPSS. Αν θέλουµε να δώσουµε ένα αναλυτικό όνοµα µε ελληνικούς χαρακτήρες 

µπορούµε να χρησιµοποιήσουµε την επιλογή [Label] (βλ. παρακάτω). 

• [Type] Εδώ επιλέγουµε το είδος των δεδοµένων για κάθε µεταβλητή. Εξορισµού 

οι νέες µεταβλητές έχουν ως type το [numeric], δηλαδή θεωρείται ότι το είδος 

των δεδοµένων είναι αριθµοί. Ενδιαφέρον παρουσιάζει και η επιλογή [string] 

που σηµαίνει ότι η µεταβλητή θα δεχθεί αλφαριθµητικά δεδοµένα (δηλαδή 

οποιονδήποτε συνδυασµό γραµµάτων και αριθµών), τα οποία δεν µπορούν να 

χρησιµοποιηθούν σε κάποια είδη αναλύσεων. Οι [dot], [comma] και [scientific 
notation] αφορούν στον τρόπο παρουσίασης των αριθµών στα κελιά, ενώ οι 

υπόλοιπες επιλογές δεν απαιτούν κάποια ιδιαίτερη εξήγηση. 

• [Width] Εδώ επιλέγουµε τον µέγιστο αριθµό χαρακτήρων που µπορούµε να 

καταχωρίσουµε για κάθε περίπτωση στην µεταβλητή µας. 

• [Decimals] Εδώ επιλέγουµε το µέγιστο αριθµό δεκαδικών που µπορούµε να 

καταχωρήσουµε για κάθε περίπτωση στην µεταβλητή µας. 

• [Label] Εδώ µπορούµε να δώσουµε ένα «δεύτερο όνοµα» στη µεταβλητή µε 

ελληνικούς χαρακτήρες, κενά ή ό,τι άλλο θέλουµε µε µήκος έως 256 χαρακτήρες. 

Είναι σηµαντικό να προσέξουµε την ορθογραφία των περιγραφών µας, πεζά – 

κεφαλαία γράµµατα κλπ., ώστε να βελτιώσουµε την αναγνωσιµότητα των 

αποτελεσµάτων, καθώς το [Label] (για όσες µεταβλητές έχει οριστεί) 

χρησιµοποιείται στους πίνακες που θα κατασκευάσει το SPSS. 

• [Values] Συχνά, απαιτείται (για λόγους ευκολίας) να κωδικοποιήσουµε τις 

κατηγορίες των µεταβλητών σε αριθµητική µορφή. Για παράδειγµα, το “άνδρας” 

και “γυναίκα” µπορεί να κωδικοποιηθεί ως “1” και “2” αντίστοιχα. Προκειµένου να 

αποφύγουµε τη σύγχυση, συνιστάται να χρησιµοποιούµε ετικέτες για τις 

διάφορες τιµές. Για παράδειγµα, η τιµή/Value:1 θα αντιστοιχούσε στην 
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ετικέτα/Value label: Άντρας. Παρόµοια, το Value:2 θα µπορούσε να 

κωδικοποιηθεί µε το Value Label: Γυναίκα. 

•  [Missing] Εδώ µπορούµε να ορίσουµε συγκεκριµένες τιµές που το SPSS θα 

εκλαµβάνει ως ελλιπείς κατά την ανάλυση των δεδοµένων. Αν για µία περίπτωση 

αφήσουµε κενό το κελί που αντιστοιχεί στη στήλη µίας µεταβλητής το SPSS 

αυτόµατα θα θεωρήσει ότι η συγκεκριµένη περίπτωση είναι ελλιπής ως προς τη 

συγκεκριµένη µεταβλητή. Οι περιπτώσεις αυτές εµφανίζονται στο output ως 

system missing (βλ. Πίνακα 2.1)  

Πίνακας 2.1 Παρουσίαση των system missing περιπτώσεων στο output 

 Φύλο 
 

  Frequency Percent Valid Percent 
Cumulative 

Percent 
Άντρας 636 41,9 41,9 41,9 
Γυναίκα 881 58,0 58,1 100,0 

Valid 

Total 1517 99,9 100,0   
Missing System 2 ,1    
Total 1519 100,0    

 
• Αντίθετα, στην περίπτωση που ορίσουµε συγκεκριµένες τιµές στο πεδίο missing, 

τότε το SPSS τις εµφανίζει ως απλώς missing και αντί της ένδειξης system 

αναφέρει την τιµή που ορίσαµε στο πεδίο [discrete missing values] ή το [label] 
που έχουµε ορίσει για τη συγκεκριµένη τιµή. Στο παράδειγµα του Πίνακα 2.2 η 

τιµή που ορίσαµε είναι η 8, δηλαδή είπαµε στο SPSS να θεωρήσει κάθε 

καταχώρηση στη συγκεκριµένη µεταβλητή που έχει τιµή 8 ως ελλιπή περίπτωση. 

 
Πίνακας 2.2   Παρουσίαση των discrete missing values στο output 

 
 Φύλο 
 

  Frequency Percent Valid Percent 
Cumulative 

Percent 
Άντρας 636 41,9 41,9 41,9 
Γυναίκα 881 58,0 58,1 100,0 

Valid 

Total 1517 99,9 100,0   
Missing 8 2 ,1    
Total 1519 100,0    
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• [Columns] Εδώ επιλέγουµε το πλάτος της στήλης της µεταβλητής, όπως θα 

εµφανίζεται στην κατάσταση προβολής [Data view]. ∆εν επηρεάζεται ο 

πραγµατικός αριθµός χαρακτήρων που µπορεί να δεχθεί η µεταβλητή (βλ. 

επιλογή [Width]). 

• [Align] Εδώ επιλέγουµε τον τρόπο που θα στοιχίζονται τα δεδοµένα στα κελιά. 

• [Measure] Εδώ επιλέγουµε την κλίµακα µέτρησης της µεταβλητής. 

Στο παράδειγµα του Σχήµατος 2.1, µπορούµε να αντικαταστήσουµε το "var00001" µε 

"RT" (Reaction Time – Χρόνος Αντίδρασης) και το "var00002" µε “freq” (frequency), 

χρησιµοποιώντας την επιλογή [Name] (βλ. Σχήµα 2.3). Η εικόνα που θα έχουµε στην 

κατάσταση προβολής [Data View] είναι η ακόλουθη (βλ. Σχήµα 2.4). Αν ορίσουµε και 

κάποιο [Label] για τις µεταβλητές µας, µπορούµε να το δούµε στην κατάσταση 

προβολής [Data View] αφήνοντας το δείκτη του ποντικιού µας χωρίς να τον κουνάµε 

πάνω στο όνοµα µίας µεταβλητής. 

 

Σχήµα 2.4 Η αλλαγή του ονόµατος των µεταβλητών 
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Αφού έχουµε πληκτρολογήσει τα δεδοµένα µας πρέπει να αποθηκεύσουµε το αρχείο. 

Στην πραγµατικότητα απαιτείται να αποθηκεύουµε πολύ συχνά κατά τη διάρκεια της 

πληκτρολόγησης των δεδοµένων, προκειµένου να αποφύγουµε την απώλειά τους λόγω 

κάποιου «ατυχήµατος» (βλ. Σχήµα 2.5). 

 

Σχήµα 2.5 Το µενού [File] για την αποθήκευση των δεδοµένων 

 
 

Το SPSS προσφέρει µια ευρεία γκάµα επιλογών από µορφοποιήσεις για την 

αποθήκευση των δεδοµένων (βλ. Σχήµα 2.6). Ο κατάλογος των διαθέσιµων 

µορφοποιήσεων είναι προσβάσιµος µέσω του Save as type: στο πλαίσιο διαλόγου 

SaveAs. 

 

Σχήµα 2.6 Το µενού επιλογών τύπου µορφοποίησης του αρχείου δεδοµένων 

 
 

Αν σκοπεύετε να εργαστείτε µόνο στο SPSS, τότε είναι προτιµότερο να αποθηκεύσετε 

µε τη µορφοποίηση SPSS (*.sav). Αυτή η µορφοποίηση επιτρέπει ταχύτερη ανάγνωση 
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και επεξεργασία του αρχείου των δεδοµένων. Ωστόσο, αν πρόκειται να αναλύσετε ή να 

χρησιµοποιήσετε τα δεδοµένα σας και µέσα από κάποια άλλη εφαρµογή (π.χ., ένα 

λογιστικό φύλλο), θα σας συµβούλευα να τα αποθηκεύσετε σε ένα πιο διαδεδοµένο 

τύπο µορφοποίησης [π.χ., Excel(*.xls), 1-2-3 Rel 3.0 (*.wk3)]. 

Αφού επιλέξετε τύπο αρχείου, πληκτρολογήστε το όνοµα του αρχείου, χωρίς την 

προέκταση (π.χ., sav, xls). Μπορείτε επίσης να αποθηκεύσετε το αρχείο σας σε ένα 

σχετικό κατάλογο στο σκληρό δίσκο ή τη δισκέτα σας. 

Προσοχή! ∆εν είναι σπάνιο να ψάχνουµε ένα αρχείο µας για ώρες επειδή το 

αποθηκεύσαµε σε έναν άσχετο κατάλογο. 
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3.0 Περιγραφική Στατιστική 

Ας υποθέσουµε ότι έχετε περάσει ήδη τα δεδοµένα σας στην εφαρµογή και έχετε 

δηµιουργήσει ένα αρχείο *.sav. Το επόµενο βήµα είναι η εξαγωγή ορισµένων 

περιγραφικών στατιστικών δεικτών. 

Για να γνωρίζουµε πώς πρέπει να περιγράψουµε µία µεταβλητή, πρέπει να γνωρίζουµε 

την κλίµακα µέτρησής της. Συνοπτικά ισχύουν τα ακόλουθα: 

 

Μεταβλητή (Κλίµακα µέτρησης) Περιγραφική στατιστική 

Κατηγορική Κατανοµή συχνότητας 

Τακτική ∆είκτες κεντρικής τάσης και διασποράς 

(∆ιάµεσος, εύρος) 

Aριθµητική ∆είκτες κεντρικής τάσης και διασποράς  

(Μέσος όρος, τυπική απόκλιση) 

 

Κάθε φορά που «τρέχουµε» µια στατιστική επεξεργασία, τα αποτελέσµατα στέλνονται 

στην οθόνη εξόδου (Output). Αν τρέξουµε αρκετές επεξεργασίες κατά τη διάρκεια µιας 

εργασίας µας, τα αποτελέσµατα θα συσσωρευτούν µε τη σειρά στο παράθυρο αυτό. 

Ωστόσο, µπορούµε να οργανώσουµε καλύτερα τα αποτελέσµατά µας ανοίγοντας ένα 

καινούριο παράθυρο πριν να τρέξουµε κάθε επεξεργασία - [File=>New=>Output]. 
Επιπλέον, τα περιεχόµενα αυτών των παραθύρων µπορούν να αποθηκευτούν για 

µελλοντική χρήση ή για αντιγραφή σε κάποιο έγγραφο του Word. 

 

3.1 Κατανοµή συχνότητας 

Για να ξεκινήσετε, κάντε κλικ στα [Analyze=>Descriptive Statistics=>Frequencies]. 

 

Το αποτέλεσµα είναι ένα καινούριο παράθυρο διαλόγου που επιτρέπει στο χρήστη να 

επιλέξει τις µεταβλητές που τον ενδιαφέρουν. Προσέξτε επίσης και τα υπόλοιπα ενεργά 

κουµπιά στα άκρα του παραθύρου. Τα κουµπιά µε τον τίτλο [Statistics...] και [Charts...] 
είναι τα πιο σηµαντικά. Στο Σχήµα 3.1 που ακολουθεί, ο χρήστης ενδιαφέρεται για τη 
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µεταβλητή sex, την επιλέγει και κάνει κλικ στο βέλος που δείχνει δεξιά. Το αποτέλεσµα 

αυτής της ενέργειας είναι η µεταφορά της µεταβλητής στη λίστα των µεταβλητών 

Variable(s):. Στο σηµείο αυτό, κάνοντας κλικ στο κουµπί [OK], θα ανοίξει ένα παράθυρο 

output µε τις πληροφορίες για τις συχνότητες καθεµίας από τις τιµές της µεταβλητής.  

Σχήµα 3.1 Η εντολή Frequencies 

 

 

Τα αποτελέσµατα της εντολής Frequencies  παρουσιάζονται στον Πίνακα 3.1: 

Πίνακας 3.1 Κατανοµή συχνότητας 

 Φύλο 
 

  Frequency Percent Valid Percent 
Cumulative 

Percent 
Άντρας 636 41,9 41,9 41,9 
Γυναίκα 881 58,0 58,1 100,0 

Valid 

Total 1517 99,9 100,0   
Missing System 2 ,1    
Total 1519 100,0    

 
 

Η στήλη Frequency µας δείχνει την απόλυτη συχνότητα των τιµών της µεταβλητής στο 

δείγµα µας προσέφεραν µία συγκεκριµένη τιµή. Για παράδειγµα, στον Πίνακα 3.1 

φαίνεται ότι 636 από τους συµµετέχοντές µας ήταν άντρες.  

 

Η στήλη Percent και Valid Percent µας δείχνουν τη σχετική συχνότητα των τιµών της 

µεταβλητής στο δείγµα µας, η πρώτη επί του συνόλου των περιπτώσεων και η δεύτερη 
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επί του συνόλου των περιπτώσεων που έδωσαν έγκυρες απαντήσεις. Το σύνολο των 

περιπτώσεων στο παράδειγµά µας είναι 1519 (συµπεριλαµβανοµένων των 2 system 

missing περιπτώσεων), ενώ το σύνολο των έγκυρων περιπτώσεων είναι 1517. Οι δύο 

στήλες είναι ίσες όταν δεν υπάρχουν ελλιπείς περιπτώσεις. 

 

Η στήλη cumulative Percent αφορά στην αθροιστική σχετική συχνότητα των τιµών της 

µεταβλητής στο δείγµα µας και δεν έχει νόηµα για όλες τις µεταβλητές (παρότι το SPSS 

υπολογίζει την αθροιστική σχετική συχνότητα κάθε φορά που θα του ζητήσουµε να µας 

κατασκευάσει µία κατανοµή συχνότητας χρησιµοποιώντας την εντολή Frequencies). Η 

αθροιστική σχετική συχνότητα προφανώς δεν έχει εφαρµογή σε µεταβλητές που έχουν 

µόνο δύο κατηγορίες όπως στο παράδειγµά µας, αλλά και γενικώς σε όσες µεταβλητές 

δεν έχει νόηµα η άθροιση των σχετικών συχνοτήτων. Στις περιπτώσεις αυτές θα πρέπει 

να µην συµπεριλαµβάνεται στα αποτελέσµατα που θα παρουσιάσουµε. 

Στον Πίνακα 3.2 παρουσιάζεται µία κατανοµή συχνότητας όπου η σχετική αθροιστική 

συχνότητα έχει νόηµα. Πρόκειται για µία κατανοµή συχνότητας του αριθµού των παιδιών 

των συµµετεχόντων. Ο λόγος που δεν περιγράφουµε τη µεταβλητή ως µετρηµένη σε µία 

αριθµητική κλίµακα είναι ότι έχουµε επιτρέψει την απάντηση «περισσότερα από 8». Εδώ 

η σχετική αθροιστική συχνότητα 44,7% για την απάντηση 1 παιδί σηµαίνει ότι το 44,7% 

των συµµετεχόντων είχαν ένα ή κανένα παιδί και προκύπτει από την άθροιση των 

σχετικών συχνοτήτων των απαντήσεων κανένα παιδί και ένα παιδί  

(27,8 + 16,9 = 44,7). Αντίστοιχα, η σχετική αθροιστική συχνότητα 99,2% για την 

απάντηση 4 παιδιά σηµαίνει ότι το 99,2% των συµµετεχόντων είχαν από κανένα έως 4 

παιδιά, ή από 4 παιδιά έως κανένα. 
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Πίνακας 3.2 Σχετική αθροιστική συχνότητα 

 
 
 

Number of Children 
 
 
   Frequency Percent Valid Percent 

Cumulative 
Percent 

0 419 27,6 27,8 27,8 
1 255 16,8 16,9 44,7 
2 375 24,7 24,9 69,5 
3 215 14,2 14,2 83,8 
4 127 8,4 8,4 92,2 
5 54 3,6 3,6 95,8 
6 24 1,6 1,6 97,3 
7 23 1,5 1,5 98,9 
Περισσότερα 
από 8 17 1,1 1,1 100,0 

Valid 

Total 1509 99,3 100,0   
∆εν απαντώ 8 ,5    
System 2 ,1    

Missing 

Total 10 ,7    
Total 1519 100,0    
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3.2 ∆είκτες κεντρικής τάσης και διασποράς  

Για να ζητήσουµε από το SPSS να υπολογίσει τους δείκτες κεντρικής τάσης και 

διασποράς που επιθυµούµε, µπορούµε να χρησιµοποιήσουµε και πάλι την εντολή 

Frequencies (υπάρχουν και άλλοι τρόποι, αλλά τα αποτελέσµατα που θα πάρουµε δεν 

αλλάζουν). 

Κάνουµε πάλι κλικ στα [Analyze=>Descriptive Statistics=>Frequencies] και 

βεβαιωνόµαστε ότι στην πρώτη οθόνη που θα εµφανιστεί (βλ. Σχήµα 3.1) 

απενεργοποιούµε την επιλογή [display frequency tables], ώστε το SPSS να µην 

κατασκευάσει κατανοµές συχνότητες για τις µεταβλητές που θα συµµετάσχουν στις 

αναλύσεις. Αυτή η κίνηση θα οδηγήσει στην εµφάνιση του ακόλουθου µηνύµατος (βλ. 

Σχήµα 3.4), το οποίο µας ενηµερώνει ότι αν συνεχίσουµε χωρίς να επιλέξουµε κάποιους 

δείκτες, η ανάλυσή µας δε θα έχει κανένα output. 

 

Σχήµα 3.4 Εντολή Frequencies - Προειδοποιητικό µήνυµα 

 

 

Κάνουµε κλικ στην επιλογή OK και στη συνέχεια κάνουµε κλικ στο πλήκτρο [Statistics] 
που οδηγεί στην εµφάνιση της οθόνης του Σχήµατος 3.5. Στην οθόνη αυτή επιλέγουµε 

το Mean από το πεδίο Central Tendency και Std. deviation από το πεδίο Dispersion 

για τις αριθµητικές µεταβλητές και Median από το πεδίο Central Tendency και Range 

από το πεδίο Dispersion για τις τακτικές µεταβλητές. 
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Σχήµα 3.5 Εντολή Frequencies – επιλογή Statistics 

 

Το output που θα παίρναµε, αν διαλέγαµε ταυτόχρονα όλες τις παραπάνω επιλογές 

είναι το ακόλουθο (βλ. Πίνακα 3.3). 

Πίνακας 3.3 ∆είκτες κεντρικής τάσης και διασποράς 

Statistics 
 

Ηλικία συµµετεχόντων 
Valid 1514N 
Missing 5

Mean 45,63
Median 41,00
Std. Deviation 17,808
Range 71

 
 

Στον Πίνακα 3.3 βλέπουµε ότι είχαµε 1514 έγκυρες απαντήσεις και 5 ελλιπείς 

περιπτώσεις.  

Mean είναι ο µέσος όρος που δείχνει την τιµή που θα είχαν όλες οι περιπτώσεις αν θα 

είχαν την ίδια τιµή.  

Median είναι η διάµεσος και αποτελεί τη µεσαία τιµή µίας κατανοµής. Αυτό σηµαίνει ότι 

κατά το µέγιστο το 50% των περιπτώσεων λαµβάνουν τιµές µικρότερες της διαµέσου και 

κατά το µέγιστο το 50% µεγαλύτερες της διαµέσου. Το ακριβές ποσοστό των 

περιπτώσεων που βρίσκονται κάτω ή πάνω από τη διάµεσο καθορίζεται από το 

ποσοστό των τιµών που ισούνται µε τη διάµεσο. 



Σύντοµο Εγχειρίδιο SPSS 13.0  21 
 
 
Std. Deviation είναι η τυπική απόκλιση. Η τυπική απόκλιση δείχνει πόσο πολύ 

“απλώνονται” οι τιµές της κατανοµής. Η τυπική απόκλιση εκφράζεται σε µονάδες 

µέτρησης ίδιες µε αυτές του µέσου όρου, και όσο µικρότερη είναι τόσο πιο κοντά στο 

µέσο όρο είναι η περισσότερες τιµές της κατανοµής. Αν πολλές από τις τιµές της 

κατανοµής βρίσκονται µακριά από το µέσο όρο, τότε η τυπική απόκλιση είναι 

µεγαλύτερη. 

Range είναι το εύρος. Το εύρος είναι η έκταση του µικρότερου διαστήµατος που περιέχει 

όλα τα δεδοµένα και προκύπτει από τη διαφορά της µικρότερης παρατηρούµενης τιµής 

από τη µεγαλύτερη παρατηρούµενη τιµή. 

 

3.3 Ανάλυση πολλαπλών απαντήσεων 

Η ανάλυση πολλαπλών απαντήσεων χρησιµοποιείται όταν σε µία ερώτηση έχουµε 

επιτρέψει στους συµµετέχοντές µας να δώσουν περισσότερες από µία απαντήσεις. Για 

παράδειγµα µπορεί να ρωτήσουµε τους συµµετέχοντες µας «ποιες από τις παρακάτω 

πόλεις έχετε επισκεφθεί;». Στην περίπτωση αυτή θέλουµε να µπορούµε να 

καταχωρήσουµε στο SPSS όλους τους πιθανούς συνδυασµούς πόλεων: Να µην έχει 

επισκεφθεί καµία, να έχει επισκεφθεί µία, δύο ή και τις τρεις πόλεις.  

Για να το επιτύχουµε αυτό καταχωρίζουµε κάθε απάντηση ως µία µεταβλητή και 

κωδικοποιούµε 1 για το «ναι» και 0 για το όχι. Έτσι ένας συµµετέχοντας που έχει 

επισκεφθεί και τις τρεις πόλεις θα είχε 1 – 1 – 1 στις τρεις µεταβλητές του Πίνακα 3.4, 

ένας συµµετέχων που δεν είχε επισκεφθεί καµία πόλη 0 – 0 – 0 και ένας συµµετέχων 

που είχε επισκεφθεί µόνο τον Βόλο 0 – 1 – 0. 

 
Πίνακας 3.4  Καταχώρηση δεδοµένων για την ανάλυση πολλαπλών απαντήσεων 

lamia volos patra 
1 1 1 
0 0 0 
0 1 0 
0 1 1 
0 0 1 
1 0 0 
1 1 0 
… … … 
… … … 
0 1 1 
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Προκειµένου να εκτελέσουµε µία ανάλυση πολλαπλών απαντήσεων επιλέγουµε 

[Analyze=>Multiple Response=>Define Sets…] και εµφανίζεται η οθόνη του Σχήµατος 

3.6: 

Σχήµα 3.6 Ανάλυση πολλαπλών απαντήσεων – Define Sets 

 

Στην οθόνη του Σχήµατος 3.6 επιλέγουµε τις µεταβλητές – απαντήσεις που αντιστοιχούν 

στην ερώτησή µας και δηµιουργούµε ένα set απαντήσεων µεταφέροντας τις σχετικές 

µεταβλητές στη λίστα Variables in Set:. Στην συνέχεια στο πεδίο Variables Are Coded 
As επιλέγουµε Dichotomies και στην συνέχεια στο πεδίο Counted Value: 
καταχωρούµε τον κωδικό που αντιστοιχεί στο «ναι» (1 στο παράδειγµά µας). ∆ίνουµε 

ένα όνοµα στο set που δηµιουργήσαµε στο πεδίο Name: και πατάµε το πλήκτρο [Add] 
στα δεξιά της οθόνης. Η οθόνη που θα πάρουµε είναι η ακόλουθη (βλ. Σχήµα 3.7): 
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Σχήµα 3.7 Ανάλυση πολλαπλών απαντήσεων – ορισµός set 

 

Όπως βλέπουµε στο Σχήµα 3.7, στη λίστα Mult Response Sets: έχει προστεθεί το set 

που µόλις δηµιουργήσαµε ($poleis στο παράδειγµά µας). Επαναλαµβάνουµε την ίδια 

διαδικασία για όσα όλα sets απαντήσεων υπάρχουν στο αρχείο δεδοµένων µας και 

πατάµε το πλήκτρο [Close]. 

Στη συνέχεια επιλέγουµε [Analyze=>Multiple Response=>Frequencies…] 
προκειµένου να δηµιουργήσουµε µία κατανοµή πολλαπλών απαντήσεων για το set 

απαντήσεων που δηµιουργήσαµε. Η οθόνη που παίρνουµε είναι η ακόλουθη (βλ. Σχήµα 

3.8): 

Σχήµα 3.8 Ανάλυση πολλαπλών απαντήσεων – frequencies 
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Στην οθόνη του Σχήµατος 3.8 επιλέγουµε τα sets απαντήσεων που µας ενδιαφέρουν και 

τα µεταφέρουµε στη λίστα Table(s) for: και στη συνέχεια πατάµε το πλήκτρο [OK]. Στην 

έξοδο θα πάρουµε τα αποτελέσµατα που βλέπουµε στον Πίνακα 3.5: 

Πίνακας 3.5 Ανάλυση πολλαπλών απαντήσεων – απαντήσεων 

$poleis Frequencies

329 47,1% 67,0%
206 29,5% 42,0%
163 23,4% 33,2%
698 100,0% 142,2%

Λαµία
Βόλος
Πάτρα

$poleisa

Total

N Percent
Responses Percent of

Cases

Dichotomy group tabulated at value 1.a. 
 

 
Οι δύο πρώτες στήλες του Πίνακα 3.5 αφορούν στις απόλυτες και σχετικές συχνότητες 

επί των απαντήσεων (Responses) και όχι επί των συµµετεχόντων. Όπως βλέπουµε 

συνολικά στην ερώτησή µας δόθηκαν 698 θετικές απαντήσεις, 329 για τη Λαµία, 206 για 

το Βόλο και 163 για την Πάτρα. Το 47,1% των απαντήσεων ήταν θετικές απαντήσεις για 

τη Λαµία, το 29,5% για το Βόλο και το 23,4% για την Πάτρα.  

Στην τρίτη στήλη βλέπουµε σχετικές συχνότητες επί των συµµετεχόντων (Cases). Όπως 

είδαµε κάθε συµµετέχων µπορούσε να δώσει περισσότερες από µία θετικές απαντήσεις 

(από καµία µέχρι τρεις) και αυτός είναι ο λόγος που το οι σχετικές συχνότητες αθροίζουν 

142,2% και όχι 100%. Αυτό σηµαίνει ότι κατά µέσο όρο ο κάθε συµµετέχων προσέφερε 

1,42 θετικές απαντήσεις. 

Ο σωστός τρόπος να διαβαστεί η τρίτη στήλη του Πίνακα 3.5 είναι ο ακόλουθος: 67,0% 

των συµµετεχόντων ανέφεραν µεταξύ των πόλεων που έχουν επισκεφθεί τη Λαµία, 

42,0% το Βόλο και 33,2% την Πάτρα. 

Επιλέγοντας [Analyze=>Multiple Response=>Crosstabs…] µπορούµε να 

δηµιουργήσουµε πίνακες διπλής εισόδου χρησιµοποιώντας συνδυασµούς set 

απαντήσεων και µεταβλητών. Η οθόνη που εµφανίζεται είναι η ακόλουθη (βλ. Σχήµα 

3.9): 
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Σχήµα 3.8 Ανάλυση πολλαπλών απαντήσεων – crosstabs 

 
 
• Στα πεδία Row(s): και Columns: βάζουµε τις µεταβλητές που θα παρουσιάζονται 

στον πίνακα διπλής εισόδου. Στο παράδειγµά µας επιλέξαµε το set απαντήσεων 

που ορίσαµε προηγουµένως ($poleis) για τις σειρές του πίνακα και τη µεταβλητή 

φύλο (sex) για τις στήλες του πίνακα.  

• Όπως βλέπετε στο Σχήµα 3.8 εµφανίζονται δύο λατινικά ερωτηµατικά δίπλα από το 

όνοµα της µεταβλητής sex.  Στα ερωτηµατικά αυτά πρέπει να αντιστοιχήσουµε τους 

κωδικούς που αντιστοιχούν στις κατηγορίες της µεταβλητής. Επιλέγουµε τη 

µεταβλητή οµαδοποίησης και κάνουµε κλικ στο πλήκτρο  [Define Ranges…], µε 

αποτέλεσµα να εµφανιστεί η οθόνη του Σχήµατος 3.9. 

Σχήµα 3.9  Ανάλυση πολλαπλών απαντήσεων  - define ranges 

  

 

• Στην οθόνη του Σχήµατος 3.9 ορίζουµε τον ελάχιστον και τον µεγαλύτερο κωδικό 

που περιλαµβάνει όλες τις κατηγορίες της µεταβλητής. Στο παράδειγµά µας η 

µεταβλητή φύλο έχει δύο κατηγορίες: 1=Άντρας, 2=Γυναίκα και για αυτό βάζουµε 1 

στο πεδίο Minimum: και 2 στο πεδίο Maximum:.. Αν είχαµε µία άλλη µεταβλητή µε 
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πέντε κατηγορίες, οι οποίες είχαν κωδικοποιηθεί µε 1,2,3,4,5 θα βάζαµε 1 στο πεδίο 

Minimum: και 5 στο πεδίο Maximum:. Στη συνέχεια πατάµε [ΟΚ] και η οθόνη µας 

παίρνει την µορφή που παρουσιάζεται στο Σχήµα 3.10: 

Σχήµα 3.10  Ανάλυση πολλαπλών απαντήσεων  - crosstabs µετά το define 
ranges 

 

 

• Στην συνέχεια κάνουµε κλικ στο πλήκτρο [Options…] και εµφανίζεται η οθόνη του 

Σχήµατος 3.11: 

Σχήµα 3.11  Ανάλυση πολλαπλών απαντήσεων  - crosstabs - options 
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• Στην οθόνη του Σχήµατος 3.11 επιλέγουµε Row και Column στο πεδίο Cell 

Percentages. Στο πεδίο Percentages Based on µπορούµε να επιλέξουµε αν τα 

ποσοστά που θα εµφανιστούν θα βασίζοµαι στους συµµετέχοντες (Cases) ή στις 

απαντήσεις (Responses). Η προεπιλογή είναι να εµφανίζονται ποσοστά για τους 

συµµετέχοντες.  

• Πατάµε το πλήκτρο [Continue] και επιστρέφουµε στην οθόνη του Σχήµατος 3.10, 

όπου δίνουµε [ΟΚ] και παίρνουµε στην έξοδο τα ακόλουθα αποτελέσµατα (βλ. 

Πίνακα 3.6): 

Πίνακας 3.11  Ανάλυση πολλαπλών απαντήσεων  - crosstabs - αποτελέσµατα 

$poleis*sex Crosstabulation

82 247 329
24,9% 75,1%
48,0% 77,2%

97 109 206
47,1% 52,9%
56,7% 34,1%

26 137 163
16,0% 84,0%
15,2% 42,8%

171 320 491

Count
% within $poleis
% within sex
Count
% within $poleis
% within sex
Count
% within $poleis
% within sex
Count

Λαµία

Βόλος

Πάτρα

$poleis

Total

Ανδρας Γυναίκα
Φύλο

Total

Percentages and totals are based on respondents.
Dichotomy group tabulated at value 1.a. 

 
 

• Η ερµηνεία του πίνακα γίνεται σύµφωνα µε το παράδειγµα που δώσαµε για τις 

σχετικές συχνότητες επί των συµµετεχόντων (προσέξτε την υποσηµείωση: 

Percentages and totals are based on respondents.). Για την ερµηνεία πινάκων 

διπλής εισόδου δείτε το κεφάλαιο για το χ2. 
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4.0 Μετασχηµατισµοί µεταβλητών 

Αφού είδαµε πώς γίνονται οι περιγραφικές στατιστικές αναλύσεις, µπορούµε να 

αναφερθούµε σε µία σειρά πολύ σηµαντικών δυνατοτήτων του SPSS που αφορά στο 

µετασχηµατισµό των µεταβλητών µε σκοπό την αλλαγή υπαρχουσών µεταβλητών ή τη 

δηµιουργία νέων. 

 

4.1 Compute 

Η απλούστερη εντολή για τη δηµιουργία µίας νέας µεταβλητής είναι η εντολή 

[Compute]. Για να την χρησιµοποιήσουµε επιλέγουµε [Transform=>Compute] και 
εµφανίζεται η οθόνη που παρουσιάζεται στο Σχήµα 4.1. 

 

Σχήµα 4.1 Η εντολή [Compute] 

 

Στο πεδίο [Target Variable] στο πάνω αριστερά τµήµα της οθόνης πληκτρολογούµε το 

όνοµα της νέας µεταβλητής που θέλουµε να κατασκευάσουµε, ενώ στο πεδίο [Numeric 
Expression] τον αριθµητικό τύπο βάση του οποίου θα υπολογίζεται η τιµή της νέας 
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µεταβλητής για κάθε περίπτωση. Στο παράδειγµα του Σχήµατος 4.1 έχουµε επιλέξει να 

δηµιουργήσουµε τη νέα µεταβλητή sum, η οποία ισούται µε το άθροισµα των 

µεταβλητών a + b. Στον αριθµητικό τύπο µπορούµε να χρησιµοποιήσουµε οποιαδήποτε 

υπάρχουσα µεταβλητή, ένα νούµερο που επιθυµούµε ή συνδυασµό αυτών. Για 

παράδειγµα, αν υποθέσουµε ότι έχουµε ζητήσει από τους συµµετέχοντές µας το έτος 

γέννησής τους (µεταβλητή etos), µπορούµε να δηµιουργήσουµε µία νέα µεταβλητή µε 

την ηλικία τους, η οποία να ισούται µε το τρέχον έτος µείον το έτος γέννησης (δηλαδή 

ilikia=2006 – etos). 

 

4.2 Recode 

Μία δεύτερη πολύ χρήσιµη εντολή του SPSS είναι η εντολή [Recode]. Για να τη 

χρησιµοποιήσουµε επιλέγουµε [Transform=>Recode=>Into Different Variables] ή 

[Transform=>Recode=>Into Same Variables]. Η διαφορά µεταξύ των δύο επιλογών 

έγκειται στο αν οι αλλαγές θα εφαρµοσθούν σε µία υπάρχουσα µεταβλητή ή αν θα 

δηµιουργηθεί µία νέα µεταβλητή, αλλά κατά τα άλλα η λογική είναι απολύτως ίδια. Στο 

παράδειγµα που ακολουθεί θα χρησιµοποιήσουµε την επιλογή για τη δηµιουργία µίας 

νέας µεταβλητής, που είναι και πιο ασφαλής πρακτική καθώς διατηρούµε αναλλοίωτη 

και την αρχική µας µεταβλητή. 

Επιλέγοντας [Transform=>Recode=>Into Different Variables] εµφανίζεται η οθόνη 

που παρουσιάζεται στο Σχήµα 4.2.  

Σχήµα 4.2 Η πρώτη οθόνη της εντολής [Recode] 
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Ας υποθέσουµε ότι θέλουµε να µετασχηµατίσουµε τις τιµές της αριθµητικής µεταβλητής 

ηλικία (όπου έχουµε τις ηλικίες εκφρασµένες σε αριθµούς) σε κατηγορίες που 

αντιπροσωπεύουν ηλικιακές οµάδες. Επιλέγουµε από τη λίστα των µεταβλητών που 

υπάρχουν στο αρχείο µας τη µεταβλητή age και τη µεταφέρουµε στο κεντρικό παράθυρο 

(βλ. Σχήµα 4.2.). Στη συνέχεια βάζουµε το όνοµα της νέας µεταβλητής που θέλουµε να 

δηµιουργήσουµε στο πεδίο [Output Variable] στο άνω δεξιά τµήµα της οθόνης (age2 

στο παράδειγµά µας) και κάνουµε κλικ στο πλήκτρο [Old and New Values]. 
Εµφανίζεται η οθόνη που παρουσιάζεται στο Σχήµα 4.3. 

 

Σχήµα 4.3 Η δεύτερη οθόνη της εντολής [Recode] 

 

Η οθόνη αυτή χωρίζεται σε δύο πεδία. Στα αριστερά υπάρχει το πεδίο [Old Value] όπου 

δίνουµε τις συγκεκριµένες τιµές ή το εύρος των τιµών της αρχικής µεταβλητής που 

θέλουµε να αλλάξουµε. Στα δεξιά υπάρχει το πεδίο [New Value] όπου καταχωρούµε τις 

τιµές της νέας µεταβλητής που αντιστοιχούν στις τιµές της παλιάς µεταβλητής που 

επιλέξαµε στα αριστερά. Όταν ολοκληρωθεί αυτή η διαδικασία, κάνουµε κλίκ στο 

πλήκτρο [Add] και η αντιστοίχηση που επιλέξαµε εµφανίζεται στο παράθυρο 
[Old New]. 

Στο παράδειγµα που παρουσιάζεται στον Πίνακα 4.3. Χρησιµοποιήσαµε την επιλογή 

[Range] δύο φορές. Την πρώτη φορά βάλαµε τις τιµές 15 through 25 και στο πεδίο 

[New Value] την τιµή 1 και κάναµε κλικ στο πλήκτρο [Add]. Τη δεύτερη φορά βάλαµε τις 

τιµές 26 through 35 και στο πεδίο [New Value] την τιµή 2 και κάναµε κλικ στο πλήκτρο 

[Add].  
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Όταν ολοκληρώσουµε τις αντιστοιχίσεις που θέλουµε κάνουµε κλικ στο πλήκτρο 

[Continue] και επιστρέφουµε στην πρώτη οθόνη (βλ. Σχήµα 4.2), όπου κάνουµε πρώτα 

κλικ στο πλήκτρο [Change] και στη συνέχεια στο πλήκτρο [ΟΚ]. Έχουµε δηµιουργήσει 

µία νέα µεταβλητή µε το όνοµα age2, στην  οποία όποιος από τους συµµετέχοντές µας 

είχε τιµή από 15 έως 25 στην ηλικία θα έχει τιµή 1 και όποιος είχε από 26 έως 35 θα έχει 

τιµή 2. Η νέα µεταβλητή φαίνεται στην τελευταία στήλη των δεδοµένων µας. 

 

4.3 Weight Cases 

Το SPPS προσφέρει έναν επιπλέον τρόπο µετασχηµατισµού δεδοµένων µέσω της 

εντολής [Weight Cases], ο οποίος είναι πολύ χρήσιµος για την καταχώρηση και 

περαιτέρω στατιστική επεξεργασία δευτερογενών δεδοµένων. 

Η συγκεκριµένη διαδικασία ονοµάζεται κωδικοποίηση των δεδοµένων στο φύλλο 

εισαγωγής δεδοµένων. Συνήθως τα δεδοµένα εισάγονται σε στήλες και συγκεκριµένα 

µια µεταβλητή σε κάθε στήλη. Ωστόσο, η µέθοδος αυτή δεν είναι επαρκής όταν 

χρησιµοποιούµε δευτερογενή δεδοµένα ή τουλάχιστον δεν είναι η ευκολότερη.  

Ας υποθέσουµε ότι γνωρίζουµε ότι σε µία έρευνα µε δύο µεταβλητές µε δύο κατηγορίες 

η κάθε µία λάβαµε τα δεδοµένα που παρουσιάζονται στον Πίνακα 4.1. Η µεταβλητή 1 

έχει τις κατηγορίες Α και Β και η µεταβλητή 2 τις κατηγορίες Χ και Ψ. Ο πίνακας 

περιλαµβάνει τις απόλυτες συχνότητες των τιµών που προέκυψαν για κάθε συνδυασµό 

κατηγοριών (Α-Χ, Α-Ψ, Β-Χ, Β-Ψ). Για παράδειγµα, στο πάνω αριστερά κελί υπάρχει η 

απόλυτη συχνότητα των συµµετεχόντων που έδωσαν την απάντηση Α στη Μεταβλητή 1 

και την απάντηση Χ στη Μεταβλητή 2, η οποία ισούται µε 153. 

 
Πίνακας 4.1 ∆ευτερογενή δεδοµένα 

 
  Μεταβλητή 1  

  Α Β Σύνολα 

Χ 153 24 177 Μεταβλ. 2

Ψ 105 76 181 

 Σύνολα 258 100 358 



32  Μεθοδολογία Έρευνας & Στατιστική 
 
 
Ο παραπάνω πίνακας θα µπορούσε να καταχωρηθεί στο SPSS χρησιµοποιώντας 3 

µεταβλητές και τέσσερις µόνο γραµµές (2x2=4), ως εξής: 

Row Column Count 

1 1 153 

1 2 24 

2 1 105 

2 2 76 

 

Στις στήλες Row και Column δηµιουργούµε όλους τους πιθανούς συνδυασµούς των 

κατηγοριών των δύο µεταβλητών χρησιµοποιώντας τους αριθµούς 1 και 2. Στη στήλη 

Count δίνουµε την απόλυτη συχνότητα που γνωρίζουµε από τον Πίνακα. 4.1. Στη 

συνεχεία ενηµερώνουµε το SPSS ότι η µεταβλητή Count αναπαριστά την απόλυτη 

συχνότητα για κάθε µοναδικό συνδυασµό µεταξύ στήλης και γραµµής. Αυτό γίνεται στην 

εντολή WEIGHT και για να το κάνουµε αυτό επιλέγουµε το [Data => Weight Cases]. 
Στο παράθυρο που ανοίγει, ενεργοποιούµε την επιλογή Weight cases by, και 

µετακινούµε τη µεταβλητή COUNT στο κουτί Frequency Variable. Αν ξεχάσουµε αυτό 

το βήµα, η τιµή σε κάθε κελί θα είναι 1 για τον πίνακα αυτόν. 

 

Αν δε χρησιµοποιούσαµε την εντολή [Weight Cases] θα έπρεπε να δηµιουργήσουµε ένα 

αρχείο δεδοµένων µε δύο µεταβλητές (Μεταβλητή 1 και Μεταβλητή 2) και σε κάθε µία 

από αυτές να καταχωρήσουµε Α ή Β και Χ ή Ψ αντίστοιχα για κάθε έναν από τους 358 

συµµετέχοντες στην έρευνά µας. Αυτό εκτός από εξαιρετικά χρονοβόρο, θα ήταν εφικτό 
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µόνο αν είχαµε στη διάθεσή µας τις απαντήσεις του κάθε συµµετέχοντα ξεχωριστά και 

όχι έναν συγκεντρωτικό πίνακα, όπως π.χ. ο Πίνακας 4.1, όπως συνήθως συµβαίνει µε 

τα δευτερογενή δεδοµένα. 
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5.0 Επαγωγική Στατιστική 

Για να γνωρίζουµε πώς πρέπει να αναλύσουµε δύο ή περισσότερες µεταβλητές, πρέπει 

να γνωρίζουµε την κλίµακα µέτρησής τους. Συνοπτικά ισχύουν τα ακόλουθα: 

 
Μεταβλητή 
(Κλίµακα µέτρησης) × 

Μεταβλητή 
(Κλίµακα µέτρησης) 

Επαγωγικό στατιστικό 
κριτήριο/τεστ 

Κατηγορική 
× 

Κατηγορική χ2 

(συσχέτιση) 
[µη παραµετρικό] 

Κατηγορική 
(µέχρι 2 κατηγορίες) × 

Τακτική Mann-Whitney U 
(σύγκριση οµάδων) 
[µη παραµετρικό] 

Κατηγορική 
(πολλές κατηγορίες) × 

Τακτική Kruskall-Wallis H 
(σύγκριση οµάδων) 
[µη παραµετρικό] 

Κατηγορική 
(µέχρι 2 κατηγορίες) × 

Αριθµητική t-τεστ ανεξάρτητων δειγµάτων 
(σύγκριση οµάδων) 
[παραµετρικό] 

Κατηγορική 
(πολλές κατηγορίες) × 

Αριθµητική One-way ANOVA 
(σύγκριση οµάδων) 
[παραµετρικό] 

Τακτική(ες) 
× 

Τακτική(ες) Spearman Rho 
(συνάφειες) 
[µη παραµετρικό] 

Τακτική 

× 

Τακτική Wilcoxon 
(σύγκριση µετρήσεων ή µεταβλητών 
– 2 µεταβλητές ή µετρήσεις) 
[µη παραµετρικό] 

Τακτική(ες) 

× 

Τακτική(ες) Friedman 
(σύγκριση µετρήσεων ή µεταβλητών 
– πολλές µεταβλητές ή µετρήσεις) 
[µη παραµετρικό] 

Αριθµητική(ες) 
× 

Αριθµητική(ες) Pearson r 
(συνάφειες) 
[παραµετρικό] 

Aριθµητική 

× 

Aριθµητική t-τεστ εξαρτηµένων δειγµάτων 
(σύγκριση µετρήσεων ή µεταβλητών 
– 2 µεταβλητές ή µετρήσεις) 
[παραµετρικό] 

Aριθµητική(ες) 

× 

Aριθµητική(ες) Repeated measures ANOVA 
(σύγκριση µετρήσεων ή µεταβλητών 
– πολλές µεταβλητές ή µετρήσεις) 
[παραµετρικό] 
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5.1 Τεστ χ2 

Ο υπολογισµός του τεστ χ2 γίνεται µέσω του µενού [Analyze => Descriptive Statistics 
=> Crosstabs...]. Η οθόνη που θα εµφανιστεί παρουσιάζεται στο Σχήµα 5.1. 

 
Σχήµα 5.1 Η εντολή crosstabs 

 
 

 
• Στα κουτιά Row(s): και Column(s): βάζουµε τις µεταβλητές που θα συµµετάσχουν 

στην ανάλυση. Συνήθως προτιµούµε να βάλουµε στο κουτί  Row(s):  τη µεταβλητή 

µε τις περισσότερες κατηγορίες, ώστε ο πίνακας διπλής εισόδου που θα προκύψει 

να εκτείνεται καθ’ ύψος και όχι κατά πλάτος. 

• Στο κάτω τµήµα του κουτιού βρίσκονται τρία κουµπιά, από τα οποία το 

σηµαντικότερο είναι το κουµπί [Statistics...]. Πρέπει να κάνουµε κλικ σε αυτό και να 

επιλέξουµε το Chi-square, αλλιώς το στατιστικό κριτήριο δεν θα υπολογιστεί. Από 

τα περιεχόµενα του κουτιού αυτού προκύπτει ότι µπορούµε να υπολογίσουµε και 

άλλα κριτήρια παράλληλα προς το χ2. Η οθόνη που εµφανίζεται µε το κουµπί 

[Statistics...] παρουσιάζεται στο Σχήµα 5.2. 
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Σχήµα 5.2 Η εντολή crosstabs – επιλογή statistics 

 

 

• Αφού επιλέξουµε το Chi-square, όπως φαίνεται στο σχήµα, κάνουµε κλικ στο 

[Continue]  για να επιστρέψουµε στην αρχική οθόνη (βλ. Σχήµα 5.1). Από εκεί 

κάνουµε κλικ στο πλήκτρο [Cells…] και εµφανίζεται η οθόνη του Σχήµατος 5.3. 

Σχήµα 5.3 Η εντολή crosstabs – επιλογή cells 
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• Στην οθόνη του Σχήµατος 5.3 είναι σηµαντικό να επιλέξουµε το Row και το Column 

από το πεδίο Percentages, προκειµένου να εµφανίζονται οι σχετικές συχνότητες επί 

των γραµµών και επί των στηλών στον πίνακα διπλής εισόδου που θα κατασκευάσει 

το SPSS. Αφού ολοκληρώσουµε τις επιλογές µας, πατάµε πάλι [Continue] για να 

επιστρέψουµε στην αρχική οθόνη (βλ. Σχήµα 5.1). 

• Στην αρχική οθόνη (Σχήµα 5.1), δίνουµε [OK] για να εκτελεστεί η ανάλυση. Τα 

αποτελέσµατα της ανάλυσης φαίνονται στον Πίνακα 5.1 και 5.2. 

Πίνακας 5.1  Πίνακας διπλής εισόδου  

Race of Respondent * Respondent's Sex Crosstabulation

545 719 1264

43,1% 56,9% 100,0%

85,7% 81,6% 83,3%

71 133 204

34,8% 65,2% 100,0%

11,2% 15,1% 13,4%

20 29 49

40,8% 59,2% 100,0%

3,1% 3,3% 3,2%

636 881 1517

41,9% 58,1% 100,0%

100,0% 100,0% 100,0%

Count
% within Race of
Respondent
% within
Respondent's Sex
Count
% within Race of
Respondent
% within
Respondent's Sex
Count
% within Race of
Respondent
% within
Respondent's Sex
Count
% within Race of
Respondent
% within
Respondent's Sex

White

Black

Other

Race of
Respondent

Total

Male Female
Respondent's Sex

Total

 

• Το σηµαντικό στον Πίνακα 5.1 είναι ότι συγκρίνουµε τις σχετικές συχνότητες επί των 

στηλών και όχι τις σχετικές συχνότητες επί των σειρών. Ο λόγος είναι ότι οι σχετικές 

συχνότητες επί των σειρών (% within Race of Respondent στο παράδειγµά µας) 

επηρεάζονται από το µέγεθος των επιµέρους οµάδων που προκύπτουν από τις 

κατηγορίες της µεταβλητής. Για να ξεχωρίζετε τις σχετικές συχνότητες επί των 

σειρών να θυµάστε ότι πάντα αθροίζουν 100 οριζοντίως. Στον παραπάνω πίνακα 

συγκρίνουµε καθέτως τις σχετικές συχνότητες επί των στηλών (% within 
Respondent’s Sex στο παράδειγµά µας). 
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• Στον Πίνακα 5.1 παρουσιάζονται τα αποτελέσµατα της ανάλυσης. Αυτό που µας 

ενδιαφέρει η πρώτη σειρά Pearson Chi-Square. Στο παράδειγµα µας η συσχέτιση 

δεν είναι στατιστικώς σηµαντική, εφόσον το Sig., δηλαδή το p, είναι µεγαλύτερο του 

0,05. Στο κάτω µέρος του πίνακα υπάρχει µία υποσηµείωση που αφορά στις 

προϋποθέσεις εφαρµογής του τεστ. Το θέµα αυτό αποτελεί αντικείµενο διχογνωµίας, 

αλλά ένας καλός εµπειρικός κανόνας είναι το 20% των κελιών ή λιγότερο να έχουν 

θεωρητική συχνότητα (expected count) µικρότερη του 5.  

Πίνακας 5.2  Αποτελέσµατα του τεστ χ2 

Chi-Square Tests

5,011a 2 ,082
5,094 2 ,078

2,944 1 ,086

1517

Pearson Chi-Square
Likelihood Ratio
Linear-by-Linear
Association
N of Valid Cases

Value df
Asymp. Sig.

(2-sided)

0 cells (,0%) have expected count less than 5. The
minimum expected count is 20,54.

a. 

 
 

• Ειδικά για τις περιπτώσεις που και οι δύο µεταβλητές έχουν από δύο κατηγορίες 

(στο αρχικό µας παράδειγµα η µεταβλητή race είχε τρεις κατηγορίες) το SPSS 

υπολογίζει αυτόµατα µία επιπλέον σειρά αποτελεσµάτων (βλ. Πίνακα 5.3). Υπάρχει 

διχογνωµία ως το κατά πόσο θα πρέπει να χρησιµοποιείται η διόρθωση αυτή 

(Continuity Correction), αν δηλαδή θα πρέπει να διαβάσουµε αυτήν τη γραµµή ή 

την γραµµή Pearson Chi-Square, όπως περιγράψαµε αρχικά.  

• Ειδικά για τους πίνακες 2×2 κανένα κελί από τα τέσσερα δεν θα πρέπει να έχει 

θεωρητική συχνότητα µικρότερη του 5 (είδαµε προηγουµένως ότι ο εµπειρικός 

κανόνας θέτει ως όριο το 20%, αν έστω και ένα κελί από τα τέσσερα έχει θεωρητική 

συχνότητα µικρότερη του 5, τότε έχουµε πρόβληµα στο 25% των κελιών). 
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Πίνακας 5.3  Αποτελέσµατα του τεστ χ2 για πίνακα 2×2 
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5.2 Το t-τεστ 

Υπάρχουν δύο ειδών t-τεστ, ένα για ανεξάρτητα δείγµατα και ένα για εξαρτηµένα 

δείγµατα. Προκειµένου να ενηµερώσουµε το SPSS για αυτή την πληροφορία, χρειάζεται 

να ακολουθήσουµε δύο διαφορετικούς τρόπους εισαγωγής των δεδοµένων. Για τα 

εξαρτηµένα δείγµατα, οι δύο µεταβλητές πρέπει να εισαχθούν σε δύο στήλες. Για 

ανεξάρτητα δείγµατα, χρησιµοποιούµε µία µεταβλητή για τις µετρήσεις µας και µία 

δεύτερη µεταβλητή στην οποία καθορίζουµε την υπο-οµάδα στην οποία ανήκουν οι 

συµµετέχοντες. Όπως και στον υπολογισµό του στατιστικού κριτηρίου χ2 είναι σηµαντικό 

να εισάγουµε τα δεδοµένα µας σωστά. 

 

Το t-τεστ εξαρτηµένων δειγµάτων 

Το t-τεστ για εξαρτηµένα δείγµατα εφαρµόζεται στις περιπτώσεις που έχουµε µετρήσει 

την ίδια µεταβλητή στους ίδιους συµµετέχοντες σε δύο διαφορετικές χρονικές στιγµές 

(π.χ. πριν την παρέµβαση και µετά την παρέµβαση) ή όταν έχουµε πάρει µετρήσεις από 

τους ίδιους συµµετέχοντες για δύο µεταβλητές, χρησιµοποιώντας την ίδια κλίµακα 

µέτρησης. Οι δύο µετρήσεις ή οι δύο µεταβλητές καταχωρίζονται σε ξεχωριστές στήλες 

όπως φαίνεται στον Πίνακα 5.4. 

Πίνακας 5.4  Καταχώρηση δεδοµένων για το t-τεστ για εξαρτηµένα δείγµατα 

Mnths_6 Mnths_24 
124 114 
94 88 
115 102 
110 2 
116 2 
139 2 
116 2 
110 2 
129 2 
120 2 
105 2 
88 2 
120 2 
120 2 
116 2 
105 2 
… … 
… … 
123 132 
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Αφού εισαχθούν τα δεδοµένα, πρέπει να επιλέξουµε το [Analyze => Compare Means 
=> Paired-Samples T Test...]. Εµφανίζεται η οθόνη του Σχήµατος 5.4. 

 

Σχήµα 5.4  Το t-τεστ για εξαρτηµένα δείγµατα 

 

 

Για να επιλέξουµε τις δύο µεταβλητές, κρατάµε το πλήκτρο [Shift] πατηµένο ενώ 

χρησιµοποιούµε το ποντίκι για την επιλογή. Η εφαρµογή απαιτεί την επιλογή δύο 

µεταβλητών. Αφού έχει γίνει αυτό, τις µεταφέρουµε στη λίστα Paired Variables:. Με την 

ολοκλήρωση αυτής της διαδικασίας, πατάµε το [ΟΚ] και παίρνουµε τα εξής 

αποτελέσµατα στην έξοδο (βλ. Πίνακα 5.5): 

 

Πίνακας 5.5  Αποτελέσµατα του t-τεστ για εξαρτηµένα δείγµατα 

Paired Samples Statistics

3,19 982 1,401 ,045

4,60 982 ,756 ,024

To Obey
To Be Well Liked
or Popular

Pair
1

Mean N Std. Deviation
Std. Error

Mean

 
 

Paired Samples Correlations

982 -,253 ,000
To Obey & To Be Well
Liked or Popular

Pair
1

N Correlation Sig.
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Paired Samples Test

-1,405 1,752 ,056 -1,515 -1,296 -25,129 981 ,000
To Obey - To Be Well
Liked or Popular

Pair
1

Mean Std. Deviation
Std. Error

Mean Lower Upper

95% Confidence
Interval of the

Difference

Paired Differences

t df Sig. (2-tailed)

 
 
 
 
O πρώτος πίνακας µας δίνει περιγραφικά στατιστικά και ο δεύτερος τη συνάφεια για τις 

δύο µεταβλητές (ή για τις δύο µετρήσεις της ίδιας µεταβλητής). Ο τρίτος πίνακας µας 

δίνει την τιµή του t, τους βαθµούς ελευθερίας (στήλη df)  και το p (στήλη sig.). Η τιµή του 

p µας δείχνει ότι στο παράδειγµά µας υπάρχει στατιστικώς σηµαντική διαφορά µεταξύ 

των δύο µεταβλητών. 

 

Το t-τεστ για ανεξάρτητα δείγµατα 

Το t-τεστ για ανεξάρτητα δείγµατα εφαρµόζεται στις περιπτώσεις που θέλουµε να 

συγκρίνουµε δύο υπο-οµάδες (δείγµατα) ως προς µία µεταβλητή (π.χ. την οµάδα των 

αντρών και την οµάδα των γυναικών ως προς µία µεταβλητή). Χρησιµοποιούµε µία 

µεταβλητή οµαδοποίησης για να δηλώσουµε την οµάδα στην οποία ανήκουν οι 

συµµετέχοντες και µία µεταβλητή όπου καταχωρίζουµε τη µέτρηση που µας ενδιαφέρει 

για κάθε συµµετέχοντα, όπως φαίνεται στον Πίνακα 5.6. 

Πίνακας 5.6  Καταχώρηση δεδοµένων για το t-τεστ ανεξάρτητων δειγµάτων 

 
Group Exp_Con 
1 96 
1 127 
1 127 
1 119 
2 109 
2 143 
2 104 
2 96 
… … 
… … 
2 114 
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Για να υπολογίσουµε το στατιστικό κριτήριο t, κάνουµε κλικ στα [Analyze => Compare 
Means => Independent-Samples T Test] και εµφανίζεται η οθόνη του Σχήµατος 5.5. 

Σχήµα 5.5  Το t-τεστ για ανεξάρτητα δείγµατα 

 

• Στο κουτί Test Variable(s): βάζουµε τη µεταβλητή που περιέχει τις µετρήσεις µας 

(στο παράδειγµά µας την ηλικία των συµµετεχόντων). 

• Στο κουτί Grouping Variable: βάζουµε τη µεταβλητή οµαδοποίησης (στο 

παράδειγµά µας το φύλο των συµµετεχόντων). Όπως βλέπετε στο Σχήµα 5.5 

εµφανίζονται δύο λατινικά ερωτηµατικά δίπλα από το όνοµα της µεταβλητής 

οµαδοποίησης. Στα ερωτηµατικά αυτά πρέπει να αντιστοιχήσουµε τους κωδικούς 

που αντιστοιχούν στις οµάδες (αν δεν τους θυµόµαστε ανατρέχουµε στην προβολή 

[Variable View]). Επιλέγουµε τη µεταβλητή οµαδοποίησης και κάνουµε κλικ στο 

πλήκτρο  [Define Groups…], µε αποτέλεσµα να εµφανιστεί η οθόνη του Σχήµατος 

5.6. 

Σχήµα 5.6  Καθορισµός των οµάδων 

  

• Στην οθόνη του Σχήµατος 5.6 πρέπει να δηλώσουµε πως κωδικοποιήθηκαν οι δύο 

οµάδες στην µεταβλητή οµαδοποίησης που χρησιµοποιήσαµε. Στο παράδειγµά µας 
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η µεταβλητή οµαδοποίησης είναι το φύλο και έχουµε κωδικοποιήσει την οµάδα των 

αντρών µε 1 και την οµάδα των γυναικών µε 2. Αφού  δηλώσουµε τις τιµές, 

επιλέγουµε το [Continue] για να επιστρέψουµε στην αρχική οθόνη (βλ. Σχήµα 5.7, 

όπου τα λατινικά ερωτηµατικά έχουν αντικατασταθεί µε τους κωδικούς 1 και 2. 

Σχήµα 5.7  Το t-τεστ για ανεξάρτητα δείγµατα µετά τον καθορισµό των οµάδων 

 

  

• Πατώντας [ΟΚ] γίνεται η επεξεργασία των δεδοµένων και παίρνουµε στην έξοδο τα 

ακόλουθα (βλ. Πίνακα 5.7): 

Πίνακας 5.7  Αποτελέσµατα του t-τεστ ανεξάρτητων δειγµάτων 

Group Statistics

636 44,18 17,033 ,675
878 46,67 18,288 ,617

Respondent's Sex
Male
Female

Age of Respondent
N Mean Std. Deviation

Std. Error
Mean

 
 

Independent Samples Test

9,697 ,002 -2,693 1512 ,007 -2,492 ,925 -4,307 -,677

-2,724 1420,931 ,007 -2,492 ,915 -4,287 -,698

Equal variances
assumed
Equal variances
not assumed

Age of Respondent
F Sig.

Levene's Test for
Equality of Variances

t df Sig. (2-tailed)
Mean

Difference
Std. Error
Difference Lower Upper

95% Confidence
Interval of the

Difference

t-test for Equality of Means
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• Ο πρώτος πίνακας µας δίνει περιγραφικά στοιχεία για τις δύο οµάδες που 

συγκρίνουµε, δηλαδή µας δίνει ξεχωριστά το µέσο όρο και την τυπική απόκλιση για 

τους άντρες και τις γυναίκες. 

• Ο δεύτερος πίνακας µας δίνει τα αποτελέσµατα της ανάλυσης. Οι δύο πρώτες 

στήλες παρουσιάζουν τα αποτελέσµατα του τεστ Levene για την ισότητα των 

διακυµάνσεων, που είναι και η προϋπόθεση για την εφαρµογή του κριτηρίου t-τεστ. 

Για να επιτρέπεται η εφαρµογή του τεστ θα πρέπει το Sig. του Levene να 

υποδηλώνει οι δύο διακυµάνσεις είναι ίσες (δηλαδή να είναι µεγαλύτερο του 0,05). 

Αν το Levene είναι στατιστικώς σηµαντικό (όπως συµβαίνει στο παράδειγµά µας), 

τότε θα πρέπει να διαβάσουµε τη δεύτερη γραµµή του πίνακα (equal variances not 

assumed). 

• Ορισµένοι προτιµούν να µην κάνουν χρήση της δεύτερης γραµµής του πίνακα και 

θεωρούν ότι από τη στιγµή που δεν υπάρχει ίσες διακυµάνσεις θα πρέπει να 

χρησιµοποιηθεί το µη παραµετρικό ισοδύναµο του t-τεστ (βλ. Mann-Whitney U). 

Άλλοι πάλι, αγνοούν τελείως το τεστ Levene και θεωρούν ότι σύµφωνα µε το 

θεώρηµα του κεντρικού ορίου, αν για κάθε οµάδα έχουµε Ν µεγαλύτερο του 30 

(δηλαδή τουλάχιστον 30 άντρες και τουλάχιστον 30 γυναίκες στο παράδειγµά µας), 

µπορούµε να εφαρµόσουµε το t-τεστ, διαφορετικά θα πρέπει να εφαρµόσουµε το µη 

παραµετρικό ισοδύναµο.  

• Κάνοντας χρήση της δεύτερης γραµµής του πίνακα βλέπουµε ότι η διαφορά στο 

µέσο όρο της ηλικίας των αντρών και των γυναικών είναι στατιστικώς σηµαντική 

(p=0,007 άρα p<0,01). 
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5.3 Ανάλυση ∆ιακύµανσης Μονής Κατεύθυνσης 

Η ανάλυση διακύµανσης µονής κατεύθυνσης εφαρµόζεται στις περιπτώσεις που 

θέλουµε να συγκρίνουµε περισσότερες από δύο υπο-οµάδες (δείγµατα) ως προς µία 

µεταβλητή (π.χ. τις τρεις οµάδες που προκύπτουν από την φυλή των συµµετεχόντων ως 

προς µία µεταβλητή). Χρησιµοποιούµε µία µεταβλητή οµαδοποίησης για να δηλώσουµε 

την οµάδα στην οποία ανήκουν οι συµµετέχοντες και µία µεταβλητή όπου 

καταχωρίζουµε τη µέτρηση στη µεταβλητή που µας ενδιαφέρει για κάθε συµµετέχοντα, 

όπως φαίνεται στον Πίνακα 5.8. 

Πίνακας 5.8  Καταχώρηση δεδοµένων για την ανάλυση διακύµανσης µονής 
κατεύθυνσης 

Groups Scores 
1 9 
3 8 
3 6 
… … 
1 7 
2 7 
3 9 
3 6 
… … 
… … 
… … 
2 10 
2 19 
… … 
1 11 

 

Για να κάνουµε ανάλυση διακύµανσης µονής κατεύθυνσης κάνουµε κλικ στα [Analyze 
=> Compare Means => One-Way ANOVA] και εµφανίζεται η οθόνη του Σχήµατος 5.8. 
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Σχήµα 5.8 Ανάλυση διακύµανσης µονής κατεύθυνσης 

 

 

• Βάζουµε στο Dependent list: τη µεταβλητή που περιλαµβάνει τις µετρήσεις µας 

(στο παράδειγµα, τα έτη συστηµατικής εκπαίδευσης) και στο Factor: τη µεταβλητή 

οµαδοποίησης. Προσέξτε ότι σε αυτήν την περίπτωση δε χρειάζεται να ορίσουµε το 

πώς έχουµε κωδικοποιήσει τις επιµέρους οµάδες. 

• Κάνουµε κλικ στο πλήκτρο Options… και εµφανίζεται η οθόνη του Σχήµατος 5.9. 

επιλέγουµε Descriptive προκειµένου να πάρουµε περιγραφικά στατιστικά για τις 

επιµέρους οµάδες και Homogeneity of variance test για να πάρουµε το τεστ 

Levene. Στη συνέχεια επιλέγουµε Continue για να επιστρέψουµε στην αρχική οθόνη 

(Σχήµα 5.8). 
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Σχήµα 5.9 Ανάλυση διακύµανσης µονής κατεύθυνσης – επιλογή Options 

 

• Πατήστε το [ΟΚ] για να γίνει η ανάλυση. Τα αποτελέσµατα θα είναι ως εξής (βλ. 

Πίνακα 5.9): 

Πίνακας 5.9 Αποτελέσµατα για την ανάλυση διακύµανσης µονής κατεύθυνσης 

Descriptives

Highest Year of School Completed

1262 13,06 2,955 ,083 12,89 13,22 0 20
199 11,89 2,677 ,190 11,52 12,27 3 20

49 12,47 4,001 ,572 11,32 13,62 3 20
1510 12,88 2,984 ,077 12,73 13,03 0 20

White
Black
Other
Total

N Mean Std. Deviation Std. Error Lower Bound Upper Bound

95% Confidence Interval for
Mean

Minimum Maximum

 
 

Test of Homogeneity of Variances

Highest Year of School Completed

9,539 2 1507 ,000

Levene
Statistic df1 df2 Sig.

 
 

ANOVA

Highest Year of School Completed

240,725 2 120,362 13,746 ,000
13195,994 1507 8,756
13436,719 1509

Between Groups
Within Groups
Total

Sum of
Squares df Mean Square F Sig.
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• Στον πρώτο πίνακα παρουσιάζονται περιγραφικά στατιστικά για κάθε οµάδα 

χωριστά (στο παράδειγµά µας για τις τρεις κατηγορίες της φυλής, αλλά και για το 

σύνολο του δείγµατος). Στο δεύτερο πίνακα παρουσιάζονται τα αποτελέσµατα για το 

τεστ Levene. Και σε αυτήν την περίπτωση προϋπόθεση για την εφαρµογή της 

ανάλυσης διακύµανσης µονής κατεύθυνσης είναι οι διακυµάνσεις να είναι ίσες, κάτι 

που ισχύει όταν το τεστ Levene είναι στατιστικώς ασήµαντο. Στο παράδειγµά µας η 

προϋπόθεση της ισότητας των διακυµάνσεων δεν ικανοποιείται και κατά συνέπεια 

θα πρέπει να χρησιµοποιήσουµε το µη παραµετρικό ισοδύναµο της ανάλυσης 

διακύµανσης µονής κατεύθυνσης (βλ. παρακάτω). Στον τρίτο πίνακα 

παρουσιάζονται τα αποτελέσµατα της ανάλυσης διακύµανσης µονής κατεύθυνσης.  

• Στο παράδειγµά µας είδαµε ότι οι προϋποθέσεις για την εφαρµογή της ανάλυσης 

διακύµανσης µονής κατεύθυνσης δεν ικανοποιούνται, αλλά υπάρχουν ορισµένοι που 

και σε αυτήν την περίπτωση αγνοούν το τεστ Levene και βασιζόµενοι στο θεώρηµα 

του κεντρικού ορίου, προχωρούν σε ανάλυση διακύµανσης µονής κατεύθυνσης αν 

το Ν είναι µεγαλύτερο από τριάντα για κάθε µία από τις υπό σύγκριση οµάδες. 

• Ας υποθέσουµε ότι ακολουθούµε αυτή τη λογική και θεωρούµε ότι η ανάλυσή του 

παραδείγµατός µας είναι έγκυρη. Όπως φαίνεται στην τελευταία στήλη του τρίτου 

πίνακα, υπάρχει στατιστικώς σηµαντική διάφορά σε επίπεδο p<0,001. Αυτό σηµαίνει 

ότι όντως οι τρεις οµάδες που προκύπτουν από τη µεταβλητή φυλή διαφέρουν κατά 

στατιστικώς σηµαντικό τρόπο ως προς τα έτη συστηµατικής εκπαίδευσης που έχουν 

λάβει. Αυτή η διαπίστωση δεν είναι αρκετή, καθώς σε αντίθεση µε ότι συνέβαινε στο 

t-τεστ, εδώ συγκρίνουµε περισσότερες από δύο οµάδες και κατά συνέπεια δεν 

γνωρίζουµε που ακριβώς βρίσκονται οι στατιστικώς σηµαντικές διαφορές. ∆ιαφέρουν 

όλες οι οµάδες µεταξύ τους ή µόνο κάποιες από αυτές; 

• Η απάντηση στο ερώτηµα αυτό γίνεται µε εκ των υστέρων κατά ζεύγη συγκρίσεις 

(post hoc), δηλαδή µε µία διαδικασία που διερευνούµε την ύπαρξη πιθανών 

διαφορών σε όλους τους δυνατούς συνδυασµούς ζευγών οµάδων. Όπως είδαµε η 

µεταβλητή φυλή έχει τρεις κατηγορίες: White, Black και Other. Άρα οι πιθανοί 

συνδυασµοί είναι οι ακόλουθοι: 

- White × Black 

- White × Other 
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- Black × Other 

• Επειδή οι ίδιες οµάδες ή κατηγορίες συµµετέχουν σε περισσότερες από µία 

αναλύσεις, είναι πιθανό να εκληφθούν ως στατιστικώς σηµαντικές διαφορές που δεν 

είναι, για τυχαίους λόγους. Για το λόγο αυτό κατά τις εκ των υστέρων κατά ζεύγη 

συγκρίσεις εφαρµόζουµε κάποια «διόρθωση» που λαµβάνει υπόψη τον αριθµό των 

συγκρίσεων κατά τον υπολογισµό της στατιστικής σηµαντικότητας. Το SPSS 

προσφέρει µεγάλο αριθµό διορθώσεων, κάθε µία από τις οποίες έχει πλεονεκτήµατα 

ανάλογα µε τις ανάγκες της ανάλυσής µας. Η απλούστερη διόρθωση που µπορούµε 

να εφαρµόσουµε είναι η διόρθωση Bonferroni.  

• Για να ζητήσουµε από το SPSS κατά ζεύγη συγκρίσεις, κάνουµε κλικ στο πλήκτρο 

[Post Hoc] από την αρχική οθόνη, το οποίο ανοίγει το ακόλουθο παράθυρο 

διαλόγου (βλ. Σχήµα 5.10): 

Σχήµα 5.10 Ανάλυση διακύµανσης µονής κατεύθυνσης – επιλογή Post Hoc 

 

 

• Eπιλέγουµε τη διόρθωση Bonferroni και πατάµε [Continue] για να επιστρέψουµε 

στην αρχική οθόνη. ∆ίνοντας [OK] εκτελείται η ανάλυση δίνοντάς µας τα ακόλουθα 

επιπλέον αποτελέσµατα (βλ. Πίνακα 5.10). 
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Πίνακας 5.10  Αποτελέσµατα για τις εκ των υστέρων κατά ζεύγη συγκρίσεις 

Multiple Comparisons

Dependent Variable: Highest Year of School Completed
Bonferroni

1,162* ,226 ,000 ,62 1,70
,587 ,431 ,520 -,45 1,62

-1,162* ,226 ,000 -1,70 -,62
-,575 ,472 ,670 -1,71 ,56
-,587 ,431 ,520 -1,62 ,45
,575 ,472 ,670 -,56 1,71

(J) Race of Respondent
Black
Other
White
Other
White
Black

(I) Race of Respondent
White

Black

Other

Mean
Difference

(I-J) Std. Error Sig. Lower Bound Upper Bound
95% Confidence Interval

The mean difference is significant at the .05 level.*. 

 
• Στην πρώτη στήλη του πίνακα φαίνεται η σύγκριση στην οποία αντιστοιχεί η κάθε 

σειρά, ενώ στην τέταρτη στήλη µας δίνεται η στατιστική σηµαντικότητα. Από την 

επισκόπηση του Πίνακα 5.10 προκύπτει ότι στατιστικώς σηµαντική διαφορά υπάρχει 

µόνο µεταξύ των κατηγοριών White και Other και όχι για τους υπόλοιπους 

συνδυασµούς κατηγοριών. 
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5.4 Ανάλυση διακύµανσης επαναλαµβανόµενων µετρήσεων 

Η ανάλυση διακύµανσης επαναλαµβανόµενων µετρήσεων εφαρµόζεται στις 

περιπτώσεις που έχουµε µετρήσει την ίδια µεταβλητή στους ίδιους συµµετέχοντες σε 

περισσότερες από δύο διαφορετικές χρονικές στιγµές (π.χ. πριν την παρέµβαση, στο 

µέσο της παρέµβασης και µετά την παρέµβαση) ή όταν έχουµε πάρει µετρήσεις από 

τους ίδιους συµµετέχοντες για περισσότερες από δύο µεταβλητές, χρησιµοποιώντας την 

ίδια κλίµακα µέτρησης. Οι µετρήσεις ή οι µεταβλητές καταχωρίζονται σε ξεχωριστές 

στήλες όπως φαίνεται στον Πίνακα 5.10. 

 

Πίνακας 5.10 Καταχώρηση δεδοµένων για την ανάλυση διακύµανσης 
επαναλαµβανόµενων µετρήσεων 

Mnths_6 Mnths_12 Mnths_24 
124 45 114 
94 12 88 
115 32 102 
110 56 2 
116 87 2 
139 45 2 
116 34 2 
110 65 2 
129 65 2 
120 76 2 
105 89 2 
88 08 2 
120 66 2 
120 88 2 
116 32 2 
105 23 2 
… … … 
… … … 
123 343 132 

 

Για να κάνουµε ανάλυση διακύµανσης µονής κατεύθυνσης κάνουµε κλικ στα [Analyze 
=> General Linear Model => Repeated Measures…] και εµφανίζεται η οθόνη του 

Σχήµατος 5.10.  
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Σχήµα 5.10 Ανάλυση διακύµανσης επαναλαµβανόµενων µετρήσεων – αρχική 
οθόνη 

 
 

• Στην οθόνη του Πίνακα 5.10 προσθέτουµε τον αριθµό των µεταβλητών ή των 

µετρήσεων της ίδιας µεταβλητής που θέλουµε να συγκρίνουµε στο πεδίο Number of 
Levels και κάνουµε κλικ στο πλήκτρο Add. Στο παράδειγµά µας θα επιλέξουµε τρία 

επίπεδα και η οθόνη µας θα έχει την ακόλουθη µορφή (βλ. Σχήµα 5.11). 
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Σχήµα 5.10 Ανάλυση διακύµανσης επαναλαµβανόµενων µετρήσεων – 
καθορισµός επιπέδων 

 
 

• Στη συνέχεια κάνουµε κλικ στο πλήκτρο [Define] και εµφανίζεται η ακόλουθη οθόνη 

(βλ. Σχήµα 5.12). 
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Σχήµα 5.12 Ανάλυση διακύµανσης επαναλαµβανόµενων µετρήσεων 

  

 

• Στην οθόνη του σχήµατος 5.12 βάζουµε στη λίστα Within-Subjects Variables τις 
µεταβλητές ή τις µετρήσεις της ίδιας µεταβλητής που επιθυµούµε να συγκρίνουµε. 

Στη συνέχεια κάνουµε κλικ στο πλήκτρο Options και εµφανίζεται η ακόλουθη οθόνη 

(βλ. Σχήµα 5.13). 
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Σχήµα 5.12 Ανάλυση διακύµανσης επαναλαµβανόµενων µετρήσεων – επιλογή 
Options 

 

 

• Στην οθόνη του σχήµατος 5.13 επιλέγουµε Descriptive Statistics από την επιλογή 

Display και πατάµε [Continue] για να επιστρέψουµε στην προηγούµενη οθόνη. Εκεί 

δίνουµε [ΟΚ] για να τρέξουµε την ανάλυση. Τα αποτελέσµατα που λαµβάνουµε είναι 

αρκετά εκτεταµένα, για αυτό στον Πίνακα 5.11 παρουσιάζουµε επιλεκτικά ένα µέρος 

τους. 

Πίνακας 5.11 Αποτελέσµατα για την Ανάλυση διακύµανσης επαναλαµβανόµενων 
µετρήσεων 

Descriptive Statistics

3,19 1,401 982

4,60 ,756 982

2,03 1,274 982

To Obey
To Be Well Liked or
Popular
To Think for Oneself

Mean Std. Deviation N
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Mauchly's Test of Sphericityb

Measure: MEASURE_1

,741 293,346 2 ,000 ,794 ,796 ,500
Within Subjects Effect
factor1

Mauchly's W
Approx.

Chi-Square df Sig.
Greenhous
e-Geisser Huynh-Feldt Lower-bound

Epsilona

Tests the null hypothesis that the error covariance matrix of the orthonormalized transformed dependent variables is
proportional to an identity matrix.

May be used to adjust the degrees of freedom for the averaged tests of significance. Corrected tests are displayed in
the Tests of Within-Subjects Effects table.

a. 

Design: Intercept 
Within Subjects Design: factor1

b. 

 
 
 

Tests of Within-Subjects Effects

Measure: MEASURE_1

3248,149 2 1624,075 887,129 ,000
3248,149 1,589 2044,202 887,129 ,000
3248,149 1,591 2041,430 887,129 ,000
3248,149 1,000 3248,149 887,129 ,000
3591,851 1962 1,831
3591,851 1558,767 2,304
3591,851 1560,884 2,301
3591,851 981,000 3,661

Sphericity Assumed
Greenhouse-Geisser
Huynh-Feldt
Lower-bound
Sphericity Assumed
Greenhouse-Geisser
Huynh-Feldt
Lower-bound

Source
factor1

Error(factor1)

Type III Sum
of Squares df Mean Square F Sig.

 
 

• Στον πρώτο πίνακα παρουσιάζονται περιγραφικά στατιστικά για τις µεταβλητές ή τις 

µετρήσεις που συµµετέχουν στην ανάλυση. Στο δεύτερο πίνακα παρουσιάζονται τα 

στοιχεία για τον έλεγχο της σφαιρικότητας. Όταν η προϋπόθεση της σφαιρικότητας 

παραβιάζεται (όταν δηλαδή το p είναι στατιστικώς σηµαντικό), τότε στον επόµενο 

πίνακα κοιτάµε τη σειρά Greenhouse-Geisser και όχι τη σειρά Sphericity Assumed. 

• Στον τρίτο πίνακα παρουσιάζονται τα αποτελέσµατα της ανάλυσης διακύµανσης. 

Επειδή δεν πληρείται το κριτήριο της σφαιρικότητας κοιτάµε τη δεύτερη γραµµή για 

τον factor 1 και διαπιστώνουµε ότι οι διαφορές που παρατηρούµε µεταξύ των τριών 

µεταβλητών είναι στατιστικώς σηµαντικές σε επίπεδο p<0,001. 

• Επειδή συγκρίνουµε περισσότερες από δύο µεταβλητές ή µετρήσεις ανακύπτει πάλι 

το πρόβληµα του εντοπισµού του που ακριβώς υπάρχουν στατιστικώς σηµαντικές 

διαφορές. Η λύση είναι και πάλι να κάνουµε εκ των υστέρων κατά ζεύγη συγκρίσεις, 
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αλλά σε αυτήν την περίπτωση το SPSS δεν προσφέρει κάποια έτοιµη εντολή. 

Μπορούµε όµως να κάνουµε εύκολα τις εκ των υστέρων συγκρίσεις 

χρησιµοποιώντας όσα περιγράφονται για το t-τεστ για εξαρτηµένα δείγµατα για 

όλους τους πιθανούς συνδυασµούς των µεταβλητών ή των µετρήσεών µας. Η 

διόρθωση Bonferroni γίνεται εύκολα µε το χέρι αν διαιρέσουµε το επίπεδο 

στατιστικής σηµαντικότητας µε τον αριθµό των συγκρίσεων που θα κάνουµε. Στο 

παράδειγµά µας χρησιµοποιούµε τρεις µεταβλητές, άρα έχουµε τρεις συγκρίσεις (η 

πρώτη µε τη δεύτερη, η πρώτη µε την τρίτη, η δεύτερη µε την τρίτη). Έτσι το επίπεδο 

στατιστικής σηµαντικότητας που πρέπει να χρησιµοποιήσουµε είναι 0,05 / 3 = 0,17 

περίπου. Αυτό σηµαίνει ότι θεωρούµε στατιστικώς σηµαντικές τις εκ των υστέρων 

συγκρίσεις όπου p<0,017. 

 



Σύντοµο Εγχειρίδιο SPSS 13.0  59 
 
 
5.5 Wilcoxon 

Το τεστ Wilcoxon είναι το µη παραµετρικό ισοδύναµο του t-τεστ για εξαρτηµένα 

δείγµατα. Εφαρµόζεται στις ίδιες περιπτώσεις και χρειάζεται να έχουµε καταχωρίσει τα 

δεδοµένα µας µε το ίδιο τρόπο. 

• Για να εκτελέσουµε το τεστ επιλέγουµε [Analyze=>Nonparametric Tests=>2 
Related Samples] και εµφανίζεται η οθόνη του Σχήµατος 5.13: 

Σχήµα 5.13 Τεστ Wilcoxon 

 

 

• Για να επιλέξουµε τις δύο µεταβλητές, κρατάµε το πλήκτρο [Shift] πατηµένο ενώ 

χρησιµοποιούµε το ποντίκι για την επιλογή. Η εφαρµογή απαιτεί την επιλογή δύο 

µεταβλητών. Αφού έχει γίνει αυτό, τις µεταφέρουµε στη λίστα Test Pair(s) List:. Με 
την ολοκλήρωση αυτής της διαδικασίας, πατάµε το [ΟΚ] και παίρνουµε τα εξής 

αποτελέσµατα στην έξοδο (βλ. Πίνακα 5.12): 
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Πίνακας 5.12 Αποτελέσµατα για το Τεστ Wilcoxon 

Ranks

205a 337,99 69288,00
777b 532,00 413365,00

0c

982

Negative Ranks
Positive Ranks
Ties
Total

To Be Well Liked or
Popular - To Obey

N Mean Rank Sum of Ranks

To Be Well Liked or Popular < To Obeya. 

To Be Well Liked or Popular > To Obeyb. 

To Be Well Liked or Popular = To Obeyc. 
 

 

Test Statisticsb

-19,742a

,000
Z
Asymp. Sig. (2-tailed)

To Be Well
Liked or
Popular -
To Obey

Based on negative ranks.a. 

Wilcoxon Signed Ranks Testb. 
 

 

• Στον πρώτο πίνακα παίρνουµε περιγραφικά στατιστικά για τις δύο µεταβλητές ή για 

τις δύο µετρήσεις της ίδιας µεταβλητής. Το SPSS µας δίνει το µέσο της ιεράρχησης ή 

το µέσο της κατάταξης (Mean Rank). 

• Στο δεύτερο πίνακα µας δίνεται η τιµή του κριτηρίου και το p. Στο παράδειγµά µας η 

διαφορά είναι στατιστικώς σηµαντική σε επίπεδο p<0,001. 

• Ορισµένοι προτιµούν να δίνουν ως περιγραφικά στατιστικά για το τεστ Wilcoxon τις 

διαµέσους και το εύρος για κάθε µεταβλητή ή για κάθε µέτρηση της ίδιας µεταβλητής. 

Το SPSS δεν υπολογίζει αυτόµατα τα στατιστικά αυτά, αλλά µπορούµε να τα 

πάρουµε ακολουθώντας τα όσα περιγράφονται στο κεφάλαιο για τους δείκτες 

κεντρικής τάσης και διασποράς. 

 



Σύντοµο Εγχειρίδιο SPSS 13.0  61 
 
 
5.6 Mann-Whitney U 

Το τεστ Mann-Whitney U είναι το µη παραµετρικό ισοδύναµο του t-τεστ ανεξάρτητων 

οµάδων. Εφαρµόζεται στις ίδιες περιπτώσεις και χρειάζεται να έχουµε καταχωρίσει τα 

δεδοµένα µας µε το ίδιο τρόπο. 

• Για να εκτελέσουµε το τεστ επιλέγουµε [Analyze=>Nonparametric Tests=>2 
Independent Samples] και εµφανίζεται η οθόνη του Σχήµατος 5.14: 

Σχήµα 5.14 Τεστ Mann-Whitney U 

 
 

• Στο κουτί Test Variable List: βάζουµε τη µεταβλητή που περιέχει τις µετρήσεις µας 

(στο παράδειγµά µας την ηλικία των συµµετεχόντων). 

• Στο κουτί Grouping Variable: βάζουµε τη µεταβλητή οµαδοποίησης (στο 

παράδειγµά µας το φύλο των συµµετεχόντων) και ακολουθούµε τη διαδικασία που 

περιγράφηκε στο t-τεστ ανεξάρτητων οµάδων προκειµένου να ορίσουµε τις οµάδες 

µε τη χρήση του πλήκτρου [Define Groups]. 

• Στη συνέχεια δίνουµε [ΟΚ] και παίρνουµε στην έξοδο τα αποτελέσµατα που 

παρουσιάζονται στον Πίνακα 5.13. 
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Πίνακας 5.13 Αποτελέσµατα για το Τεστ Mann-Whitney U 

Ranks

636 726,92 462319,50
878 779,65 684535,50

1514

Respondent's Sex
Male
Female
Total

Age of Respondent
N Mean Rank Sum of Ranks

 
 

Test Statisticsa

259753,500
462319,500

-2,317
,021

Mann-Whitney U
Wilcoxon W
Z
Asymp. Sig. (2-tailed)

Age of
Respondent

Grouping Variable: Respondent's Sexa. 
 

 
 

• Στον πρώτο πίνακα παίρνουµε περιγραφικά στατιστικά για τις δύο οµάδες. Το SPSS 

µας δίνει το µέσο της ιεράρχησης ή το µέσο της κατάταξης (Mean Rank). 

• Στο δεύτερο πίνακα µας δίνεται η τιµή του κριτηρίου (πρώτη γραµµή) και το p. Στο 

παράδειγµά µας η διαφορά είναι στατιστικώς σηµαντική σε επίπεδο p<0,05. 

• Ορισµένοι προτιµούν να δίνουν ως περιγραφικά στατιστικά για το τεστ Mann-

Whitney U τις διαµέσους και το εύρος για κάθε οµάδα. Το SPSS δεν υπολογίζει 

αυτόµατα τα στατιστικά αυτά, αλλά µπορούµε να τα πάρουµε χρησιµοποιώντας την 

εντολή [Means]. 

• Για να χρησιµοποιήσουµε την εντολή αυτή επιλέγουµε [Analyze=>Compare 
Means=>Means] και εµφανίζεται η οθόνη που παρουσιάζεται στο Σχήµα 5.15: 
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Σχήµα 5.15 Η εντολή Means 

 
 
• Βάζουµε τη µεταβλητή της µέτρησής µας λίστα Dependent List και τη µεταβλητή 

οµαδοποίησης στη λίστα Independent List και στη συνέχεια κάνουµε κλικ στο 

πλήκτρο [Options] µε αποτέλεσµα να εµφανιστεί η οθόνη του Σχήµατος 5.16. 

Σχήµα 5.15 Η εντολή Means – επιλογή Options 

  

 
• Από τη λίστα Cell Statistics αφαιρούµε τις επιλογές Mean και Standard Deviation 

και προσθέτουµε τις επιλογές Median και Range. Για να το επιτύχουµε αυτό 

κάνουµε κλικ στην κάθε επιλογή και στη συνέχεια κάνουµε κλικ στο βελάκι µεταξύ 
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των δύο λιστών. Η οθόνη µας θα πρέπει να έχει τη µορφή που φαίνεται στο Σχήµα 

5.16. 

Σχήµα 5.15 Η εντολή Means – επιλογή Options (ΙΙ) 

 

 
• Στη συνέχεια κάνουµε κλικ στο πλήκτρο [Continue] και επιστρέφουµε στην αρχική 

οθόνη, όπου δίνουµε [ΟΚ] και λαµβάνουµε στην έξοδο τα όσα παρουσιάζονται στον 

Πίνακα 5.14: 

Πίνακας 5.14  Η εντολή Means – αποτελέσµατα 

Report

Age of Respondent

636 41,00 71
878 42,00 71

1514 41,00 71

Respondent's Sex
Male
Female
Total

N Median Range

 
 
 
• Βλέπουµε ότι πήραµε τη διάµεσο και το εύρος για κάθε µία από τις κατηγορίες της 

µεταβλητής οµαδοποίησης, αλλά και για το σύνολο του δείγµατος. 
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5.7 Kruskal-Wallis H 

Το τεστ Kruskal-Wallis H είναι το µη παραµετρικό ισοδύναµο της ανάλυσης διακύµανσης 

µονής κατεύθυνσης. Εφαρµόζεται στις ίδιες περιπτώσεις και χρειάζεται να έχουµε 

καταχωρίσει τα δεδοµένα µας µε το ίδιο τρόπο. 

Για να εκτελέσουµε το τεστ επιλέγουµε [Analyze=>Nonparametric Tests=>Κ 
Independent Samples] και εµφανίζεται η οθόνη του Σχήµατος 5.16: 

Σχήµα 5.16 Kruskal-Wallis H 

 

• Στο κουτί Test Variable List: βάζουµε τη µεταβλητή που περιέχει τις µετρήσεις µας 

(στο παράδειγµά µας τα έτη συστηµατικής εκπαίδευσης). 

• Στο κουτί Grouping Variable: βάζουµε τη µεταβλητή οµαδοποίησης (στο 

παράδειγµά µας τη φυλή των συµµετεχόντων). Όπως βλέπετε στο Σχήµα 5.16 

εµφανίζονται δύο λατινικά ερωτηµατικά δίπλα από το όνοµα της µεταβλητής 

οµαδοποίησης. Στα ερωτηµατικά αυτά πρέπει να αντιστοιχήσουµε τους κωδικούς 

που αντιστοιχούν στις οµάδες, όπως κάναµε προηγουµένως για το t-τεστ 

ανεξάρτητων δειγµάτων. Επιλέγουµε τη µεταβλητή οµαδοποίησης και κάνουµε κλικ 

στο πλήκτρο  [Define Groups…], µε αποτέλεσµα να εµφανιστεί η οθόνη του 

Σχήµατος 5.17. 
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Σχήµα 5.17  Kruskal-Wallis H - Καθορισµός των οµάδων 

  

• Στην οθόνη του Σχήµατος 5.17 πρέπει να δηλώσουµε πως κωδικοποιήθηκαν οι 

οµάδες στην µεταβλητή οµαδοποίησης που χρησιµοποιήσαµε. Προσοχή στο 

γεγονός ότι η οθόνη αυτή είναι διαφορετική από αυτή που χρησιµοποιήσαµε στο t-

τεστ ανεξάρτητων δειγµάτων και στο Mann-Whitney U καθώς εδώ καλούµαστε να 

βάλουµε το εύρος της κωδικοποίησης, δηλαδή να ορίσουµε το µικρότερο και το 

µεγαλύτερο κωδικό που αντιστοιχούν στις οµάδες µας (στο παράδειγµά µας έχουµε 

τρεις φυλές κωδικοποιηµένες µε 1, 2 και 3 και για αυτό τοποθετούµε 1 στο Minimum 

και 3 στο Maximum). 

• Eπιλέγουµε το [Continue] για να επιστρέψουµε στην αρχική οθόνη (βλ. Σχήµα 

5.18), όπου τα λατινικά ερωτηµατικά έχουν αντικατασταθεί µε το εύρος κωδικών 1 

και 3. 

Σχήµα 5.18  Kruskal-Wallis H µετά τον καθορισµό των οµάδων 

 

  

• Πατώντας [ΟΚ] γίνεται η επεξεργασία των δεδοµένων και παίρνουµε στην έξοδο τα 

ακόλουθα (βλ. Πίνακα 5.15): 
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Πίνακας 5.15  Αποτελέσµατα του Kruskal-Wallis H 

Ranks

1262 779,33
199 616,52

49 706,22
1510

Race of Respondent
White
Black
Other
Total

Highest Year of
School Completed

N Mean Rank

 
 

Test Statisticsa,b

25,460
2

,000

Chi-Square
df
Asymp. Sig.

Highest Year
of School

Completed

Kruskal Wallis Testa. 

Grouping Variable: Race of Respondentb. 
 

 
• Στον πρώτο πίνακα παίρνουµε περιγραφικά στατιστικά για τις επιµέρους οµάδες. Το 

SPSS µας δίνει το µέσο της ιεράρχησης ή το µέσο της κατάταξης (Mean Rank). 

• Στο δεύτερο πίνακα µας δίνεται η τιµή του κριτηρίου και το p. Στο παράδειγµά µας η 

διαφορά είναι στατιστικώς σηµαντική σε επίπεδο p<0,001. 

• Ορισµένοι προτιµούν να δίνουν ως περιγραφικά στατιστικά για το τεστ Mann-

Whitney U τις διάµεσους και το εύρος για κάθε οµάδα. Το SPSS δεν υπολογίζει 

αυτόµατα τα στατιστικά αυτά, αλλά µπορούµε να τα πάρουµε χρησιµοποιώντας την 

εντολή Means, ακολουθώντας τη διαδικασία που περιγράφηκε για το τεστ Mann-

Whitney U. 

• Επειδή συγκρίνουµε περισσότερες από δύο επιµέρους οµάδες ανακύπτει πάλι το 

πρόβληµα του εντοπισµού του πού ακριβώς υπάρχουν στατιστικώς σηµαντικές 

διαφορές. Η λύση είναι και πάλι να κάνουµε εκ των υστέρων κατά ζεύγη συγκρίσεις, 

αλλά σε αυτήν την περίπτωση το SPSS δεν προσφέρει κάποια έτοιµη εντολή. 

Μπορούµε όµως να κάνουµε εύκολα τις εκ των υστέρων συγκρίσεις 

χρησιµοποιώντας όσα περιγράφονται για το Mann-Whitney U για όλους τους 

πιθανούς συνδυασµούς των επιµέρους οµάδων. Η διόρθωση Bonferroni γίνεται 

εύκολα µε το χέρι αν διαιρέσουµε το επίπεδο στατιστικής σηµαντικότητας µε τον 

αριθµό των συγκρίσεων που θα κάνουµε. Στο παράδειγµά µας χρησιµοποιούµε 
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τρεις επιµέρους οµάδες, άρα έχουµε τρεις συγκρίσεις (η πρώτη µε τη δεύτερη, η 

πρώτη µε την τρίτη, η δεύτερη µε την τρίτη). Έτσι το επίπεδο στατιστικής 

σηµαντικότητας που πρέπει να χρησιµοποιήσουµε είναι 0,05 / 3 = 0,17 περίπου. 

Αυτό σηµαίνει ότι θεωρούµε στατιστικώς σηµαντικές τις εκ των υστέρων συγκρίσεις 

όπου p<0,017. 

 

5.9 Friedman 

Το τεστ Friedman είναι το µη παραµετρικό ισοδύναµο για την ανάλυση διακύµανσης 

επαναλαµβανόµενων µετρήσεων. Εφαρµόζεται στις ίδιες περιπτώσεις και χρειάζεται να 

έχουµε καταχωρίσει τα δεδοµένα µας µε τον ίδιο τρόπο. 

• Για να εκτελέσουµε το τεστ επιλέγουµε [Analyze=>Nonparametric Tests=>Κ 
Related Samples] και εµφανίζεται η οθόνη του Σχήµατος 5.19: 

Σχήµα 5.19 Τεστ Friedman 

 

 

• Επιλέγουµε τις µεταβλητές ή τις µετρήσεις που θέλουµε να αναλύσουµε και τις 

µεταφέρουµε στη λίστα Test Variables:. Με την ολοκλήρωση αυτής της διαδικασίας, 

πατάµε το [ΟΚ] και παίρνουµε τα εξής αποτελέσµατα στην έξοδο (βλ. Πίνακα 5.16): 
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Πίνακας 5.16 Αποτελέσµατα για το Τεστ Friedman 

Ranks

1,89

2,72

1,39

To Obey
To Be Well Liked or
Popular
To Think for Oneself

Mean Rank

 
 

Test Statisticsa

982
884,275

2
,000

N
Chi-Square
df
Asymp. Sig.

Friedman Testa. 
 

 

• Στον πρώτο πίνακα παίρνουµε περιγραφικά στατιστικά για τις µεταβλητές ή για τις 

µετρήσεις της ίδιας µεταβλητής. Το SPSS µας δίνει το µέσο της ιεράρχησης ή το 

µέσο της κατάταξης (Mean Rank). 

• Στο δεύτερο πίνακα µας δίνεται ο αριθµός των συµµετεχόντων (Ν), η τιµή του 

κριτηρίου (Chi-Square), οι βαθµοί ελευθερίας (df) και το p (Asymp. Sig.). Στο 

παράδειγµά µας η διαφορά είναι στατιστικώς σηµαντική σε επίπεδο p<0,001. 

• Ορισµένοι προτιµούν να δίνουν ως περιγραφικά στατιστικά για το τεστ Wilcoxon τις 

διαµέσους και το εύρος για κάθε µεταβλητή ή για κάθε µέτρηση της ίδιας µεταβλητής. 

Το SPSS δεν υπολογίζει αυτόµατα τα στατιστικά αυτά, αλλά µπορούµε να τα 

πάρουµε ακολουθώντας τα όσα περιγράφονται στο κεφάλαιο για τους δείκτες 

κεντρικής τάσης και διασποράς. 
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5.10 Συνάφεια Pearson r και Spearman Rho 

Προκειµένου να υπολογίσουµε συνάφειες µε τον Pearson r ή µε το µη παραµετρικό 

ισοδύναµό του Spearman Rho. Οι µεταβλητές καταχωρίζονται σε ξεχωριστές στήλες 

όπως φαίνεται στον Πίνακα 5.17. 

Πίνακας 5.17 Καταχώρηση δεδοµένων για τον υπολογισµό συναφειών  

IQ GPA 
102 2.75 
108 4.00 
109 2.25 
118 3.00 
79 1.67 
88 2.25 
… … 
… … 
85 2.50 

 

Επιλέγουµε [Analyze => Correlate => Bivariate...] και εµφανίζεται η οθόνη του 

Σχήµατος 5.20. Στη συνέχεια επιλέγουµε και µετακινούµε τις µεταβλητές που θέλουµε να 

αναλύσουµε στη λίστα Variables: και κάνοντας κλικ στο [OK] παίρνουµε τα 

αποτελέσµατα της επεξεργασίας. 

Σχήµα 5.20 Συνάφειες – Pearson r 

 



Σύντοµο Εγχειρίδιο SPSS 13.0  71 
 
 
 

Τα αποτελέσµατα για το δείκτη Pearson r (προεπιλογή στην οθόνη του Σχήµατος 5.20) 

είναι τα ακόλουθα (βλ. Πίνακα 5.18): 

 

Πίνακας 5.18 Αποτελέσµατα για το δείκτη συνάφειας Pearson r 

Correlations

1 -,253** -,532**
,000 ,000

982 982 982
-,253** 1 -,120**
,000 ,000
982 982 982

-,532** -,120** 1
,000 ,000
982 982 982

Pearson Correlation
Sig. (2-tailed)
N
Pearson Correlation
Sig. (2-tailed)
N
Pearson Correlation
Sig. (2-tailed)
N

To Obey

To Be Well Liked or
Popular

To Think for Oneself

To Obey

To Be Well
Liked or
Popular

To Think
for Oneself

Correlation is significant at the 0.01 level (2-tailed).**. 
 

 

• Στον πρώτο πίνακα βλέπουµε το δείκτη Pearson r για όλους τους πιθανούς 

συνδυασµούς των µεταβλητών που συµµετείχαν στην ανάλυση. Η συνάφεια κάθε 

µεταβλητής µε τον εαυτό της είναι 1. Έτσι σχηµατίζεται µία διαγώνιος από 1 στις δύο 

πλευρές της οποίας επαναλαµβάνονται τα ίδια αποτελέσµατα. 

• Στον στην πρώτη γραµµή κάθε κελιού µας δίνεται ο δείκτης Pearson r, στη δεύτερη 

γραµµή το p και στην τρίτη ο αριθµός των συµµετεχόντων για τους οποίους υπήρχαν 

στοιχεία και για τις δύο µεταβλητές. 

• Με αστεράκια σηµειώνονται οι στατιστικώς σηµαντικές συνάφειες (βλ. την 

υποσηµείωση του πίνακα). 

• Στην περίπτωση των συναφειών δεν υπολογίζουµε κάποιου άλλου είδους 

περιγραφικά στατιστικά, καθώς ο δείκτης συνάφειας µας δείχνει το µέγεθος και την 

κατεύθυνση της συνάφειας. 
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Στην περίπτωση που θέλουµε να υπολογίσουµε τον µη παραµετρικό δείκτη συνάφειας 

Spearman Rho, ακολουθούµε τα ίδια ακριβώς βήµατα, αλλά στο πεδίο Correlation 
Coefficients αποεπιλέγουµε τον δείκτη Pearson r και επιλέγουµε τον δείκτη Spearman 

Rho, ώστε η οθόνη µας να έχει την µορφή του Σχήµατος 5.21. 

 
 
Σχήµα 5.20 Συνάφειες – Pearson r 

 

 

Τα αποτελέσµατα για το δείκτη Spearman Rho είναι τα ακόλουθα (βλ. Πίνακα 5.19): 
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Πίνακας 5.19 Αποτελέσµατα για το δείκτη συνάφειας Spearman Rho 

Correlations

1,000 -,418** -,529**
. ,000 ,000

982 982 982
-,418** 1,000 -,038
,000 . ,229
982 982 982

-,529** -,038 1,000
,000 ,229 .
982 982 982

Correlation Coefficient
Sig. (2-tailed)
N
Correlation Coefficient
Sig. (2-tailed)
N
Correlation Coefficient
Sig. (2-tailed)
N

To Obey

To Be Well Liked or
Popular

To Think for Oneself

Spearman's rho
To Obey

To Be Well
Liked or
Popular

To Think
for Oneself

Correlation is significant at the 0.01 level (2-tailed).**. 
 

 

• Για την ερµηνεία του πίνακα ισχύουν ακριβώς τα ίδια µε την ερµηνεία των 

αποτελεσµάτων του δείκτη Pearson r. 


